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Preface
This section provides you with notational conventions and procedures that are common to
Texas Guaranteed (TG) technical publications. The typographical notations and reader alerts
permit the user to see important information needed to make significant decisions. When the
AdvanTG Web II software uses a graphical user interface (GUI) and a command-line interface
(CLI), this guide will state which interface is in use.

Typographical Conventions
This guide uses typeface changes, symbols, and special icons to set apart information in a
structured way that makes it easy for the user to read.

Table 1: What Typeface Changes and Symbols Mean
Typeface

or Symbol
Typeface or Symbol Meaning

Text, GUI, or Command Line Interface Examples
italics Used for:

• Document or software titles
• New terms shown in text
• Words that require emphasis

AdvanTG Web II System
Maintenance Guide

Digital Encryption Standard

You must be root user to do this.

Bold Denotes graphical user interface (GUI) objects.
For example, menu titles, button labels, window
names, radio buttons, etc.

When the Windows NT
Security window displays, click
the Change Password button.

Menus » Dialog A shorthand notation used to illustrate resource
path (select menu item, cascading menu item,
and click a window dialog tab) to implement a
specific command or action.

Menu » Menu Item » Dialog Tab

[Alt]+[F] Keyboard keys are enclosed in square brackets
and bold font. If the keys must be pressed
simultaneously, a plus sign is used in the text.

Press [Ctrl]+[Alt]+[Delete] to
logon to the workstation.

Bold
fixed-width

User input that must be typed exactly such as
PC keyboard entries or a URL.

C:\>add database bhub

Fixed-width Identifies the directory path names used for
resources or command output messages.

\\server\directory\file.
ext

Bold italic
fixed-width

Identifies entities you type and are variables
within commands that must be supplied. Replace
the variable with a real value or name.

cat file_name
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Reader Alerts
This document presents notes and cautions to highlight information of direct importance to
you:

Icon Reader Alert Description
Note - Highlights special information that is pertinent to the
primary discussion. This information is important enough to you,
that it is set off from normal text, and called to your attention.

Caution - Identifies information to warn the reader about potential
data loss, improper configuration, work that may need to be
repeated, or cause potential future software problems.

AdvanTG Web v1.0 Support
For answers to AdvanTG Web v1.0 customer conversion procedures, contact:

Product Management and Business Integration Teams

Voice 512.219.4418

Email Juli Wright@tgslc.org
Voice 512.219.4646

Email Chuck Ramos@tgslc.org
Toll Free Number 800.845.6267

Street Address Texas Guaranteed Student Loan Corporation
Tower of the Hills
13809 North Hwy. 183, Suite 100
Austin, TX 78750
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Section 1 – Getting Started

Document Purpose
This document was written for multiple TG Subprocess team members to:
• Describe the automated and manual procedures necessary to convert existing AdvanTG

Web™ I users and AdvanTG desktop users, to AdvanTG Web II.
• Help TG personal understand how each Subprocess contributes to the AdvanTG Web II

customer data conversion effort.
• Describe the Customer Conversion Utilities used to convert school, lender, and servicer

information for the new AdvanTG Web II application from the existing AdvanTG Desktop,
mainframe guaranteed loans, and Loans By Web applications.

Intended Audience
Texas Guaranteed team members responsible for:
• Converting institution customers who are currently using TG's Solutions and Tools to

AdvanTG Web II.
• Validating the converted institution data to ensure that key information is present in the

AdvanTG Web  II database prior to the institution's Implementation Day.

Terminology

ADS - Application Development & Support
A Subprocess divided into an Application Support Team and a Development Team. The
Application Support team receives alerts when problems are detected and provide second-tier
troubleshooting support. They also work with Customer Services to set-up and convert new
institution data into the AdvanTG Web database. The Development Team will focus on
performing code changes and testing for enhancements and planned software releases.

BIT - Business Integration Team
Customer Services team responsible for setting-up new institution profiles and works with new
customers to get agreements signed for electronic services, setting-up user security, and
institution profiles within AdvanTG Web II. BIT also signs-off on the quality of the customer
conversion data.

BIT-Tech
A subgroup of BIT that is chiefly responsible for performing data validation during the
customer conversion effort.
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CL - CommonLine
An industry-standard data-exchange format institutions use in the student loan approval process
to communicate information. AdvanTG Web Phase II will support CommonLine version 4
(CL4) and CommonLine version 5 (CL5), since some institutions may not have upgraded their
information systems to handle the newer CommonLine version format. CommonLine allows a
school to exchange data with multiple guarantors, lenders, and servicers through a single point
of contact; thus reducing the number of contacts and simplifying the student loan process.

COB - Close of Business Day
CONS – Consultants
Customer Support members responsible for working directing with institutions to convert any
existing data, interview institutions to determine AdvanTG Web institution profile, and gather
requirements to define user roles and responsibilities.

CT – Change Transaction
Set of transactions exported from the AdvanTG Desktop and imported into AdvanTG Web II
database using a modified ChangeSend file.

FAMS - Financial Aid Management Systems
FTP – File Transfer Protocol
A standard Internet protocol used to exchange files between computers on the Internet. Used in
the Section 7 – Initial Load Process (page 61) to send the CL Response file from the mainframe
to Windows 2000 servers.

IPlanet Directory Server (see LDAP)
The Sun™ ONE Directory Server (formerly iPlanet Directory Server) is a software product
that provides a central repository for storing and managing identity profiles, access privileges,
user roles, and application/network resources.

LBP - Loans by Phone
An existing TG application (only MPN loans are offered in Loans by Phone) that  helps
students to complete Stafford loan applications through an Interactive Voice Response (IVR)
telephone system. Once the student information is completed via telephone, the application is
submitted for loan guarantee and processing.

LBW - Loans by Web
An existing TG application that offers MPN (subsidized and unsubsidized) and PLUS loans.
The student uses an Internet browser to fill in missing application information before the
application is guaranteed. Students can access Loans by Web by typing this address in their
browser: https://lbw.tgslc.org.

LDAP – Lightweight Directory Access Protocol
The protocol used by the iPlanet Directory Server to store user authentication and
authorization security information. A software protocol for enabling anyone to locate
organizations, individuals, and other resources such as files and devices in a network, whether
on the public Internet or on a corporate intranet.
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MPN – Master Promissory Note
A type of student loan application for Stafford loans. The student is directly responsible for the
loan payment. This loan application replaces the older Common App type of application for
Stafford loans. There is maximum number of years (10) and maximum loan amount limit on
one application. Several loans can be obtained from the same lender using one MPN loan
application.

Phase 1, Phase 2, or In Transition
The status of an institution's (school, lender, or servicer) data. Phase 1 denotes AdvanTG
Desktop or LBW information still in their original databases. In Transition means that this
institution's data is currently undergoing the customer conversion procedures described in
Appendix B – Customer Conversion Checklist on page 87. Phase 2 denotes a customer that can
begin using the AdvanTG Web software.

PLUS – Parent Loans for Undergraduate Students
Loans for parents with good credit histories. Permits parents to borrow to pay the education
expenses of each child who is a dependent undergraduate student enrolled at least half time.

PSG – Product Support Group
The primary Customer Services contact with external users that provides telephone support and
performs problem resolution with TG customers.

PSPS – Program Support Process System
Group responsible for "officially" changing institution information that is downloaded to
AdvanTG Web II using Section 3 - Nightly Institution Synchronization on page 34. Core
eligibility records reside on the PSPS mainframe system. Updates to these records include
address changes, contact changes, Identification Number (ID) changes, or eligibility changes
that result from institutional closures or terminations.

RRD - Report Request Distribution
A windows-based software program developed by TG that allows schools and lenders to
receive requested standard TG reports and customized guarantee volume reports electronically.
RRD system is an existing TG application system that provides faster and more convenient way
of delivering reports to schools and lenders by TG. When school/lender transmits a report
request to TG over an Internet connection, the TG mainframe processes that request in a nightly
batch process and the school/lender receives the report the beginning of next business day.

POP3 - Post Office Protocol 3
A standard  client/server protocol for receiving e-mail in which e-mail is received and held by
your Internet server. Periodically, you (or your client email receiver) check your mail-box on
the server and download any mail.

TG Warehouse
A process that runs on NT, which picks up files (from a mail server) sent by non-AdvanTG
Institutions and transfers (using FTP) the file(s) to/from mainframe for processing.

TS – Technology Services
The Network Support Engineers that provided specialized technical support for network
operations, firewall, BIG IP controller, LDAP iPlanet Directory servers, WebLogic Servers,
Parallel Crystal Servers, IIS5 (Internet Information Server 5), DB2 UDB database server, and
other specialized servers.
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How this Guide is Organized
This technical publication is organized into sections:
Preface, brief explanation of notations, reader alerts, and procedures used in TG publications.

Section 1, Getting Started, information to organize the work you intend to perform.

Section 2, <Customer Conversion Overview>, brief overview of the procedures and steps
necessary for TG Subprocesses to work together in performing the data conversion.

Section 3, <Nightly Institutions Synchronization>, defines the nightly procedure for updating
basic institution data maintained by the Program Support Process System (PSPS).

Section 4, <Customer Conversion Utilities>, describes the graphical user interface developed
to automate many of the data conversion and utility operations conducted during the customer
conversion.

Section 5, <LBW Conversion>, describes procedures to perform the LBW (Loans by Web)
conversion of institution, application, lender, certifications, and loan information.

Section 6, <Export/Import Desktop Change Transactions>, provides the procedures necessary
to convert current AdvanTG desktop change transactions to the AdvanTG Web II database.

Section 7, <Initial Load Process>, provides an overview of how current and historical loan
information is prepared for automated loading into AdvanTG Web II.

Section 8, <Mark Exported Data>, provides a brief description of a database utility that resets
the status of loans and change transactions in AdvanTG Web II.

Section 9, <Security Setup>, define the steps need to convert institution user IDs to the
AdvanTG Web II LDAP-based security system.

Section 10, <Rename AdvanTG Phase I Files>, standards used to rename institution's
AdvanTG Phase I files for AdvanTG Web II operation.

Appendix A, <Customer Institution 11/21/02 Information>, describes the conversion
operations required for the initial five tiers of TG schools and lenders.

Appendix B, <Customer Conversion 11/21/02 Checklist>, lists the major customer conversion
steps performed across different TG Subprocesses.

Appendix C, <LBW Conversion Quality Assurance>, provides SQL queries used to directly
examine LBW conversion data within LBW and AdvanTG Web databases.

Appendix D, <Customer Conversion Validation Queries>, provides SQL queries used during
the institution data conversions to verify the number of applications, loans, change transactions,
lenders, etc. processed.

Appendix E, <Internet Browser Settings>, provides Internet Browser and Proxy Server (if
used) settings for the different Windows operating systems and the two most popular browsers,
Internet Explorer and Netscape Navigator.

Index
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$/AdvWeb/Data Conversion/Data Conversion Requirements.doc

• Synchronize Institution Information (Eric Schneider)
$/AdvWeb/Testing/AddMaintainInstitution Management Component/Synch
Institution Info with Mainframe/Test Case/TC_Synchronize
Institution Information

• Initial Load Mainframe Procedures (Lori Perry)
• LBW Data Conversion Technical Notes (Eric Schneider)

$/AdvWeb/Data Conversion/LBW Conversion Procedure Notes

• BPLM Naming Convention.xls (Teresa Bobadilla)
• SplitCLResponseFile Documentation (Sam Baugher)

$/AdvWeb/Data Conversion/Data Conversion Requirements.doc

• Database Tables Data Dictionary (Lance Smith)
$/AdvWeb/System Documentation/DB2 Database Documentation/Database
Tables Data Dictionary.doc

• AdvanTG Web Database Table Layouts (Lance Smith)
$/AdvWeb/System Documentation/DB2 Database
Documentation/AdvanTG_Web_DB_Tables.xls
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Section 2 – Customer Conversion Overview

Customer Institutions
Surrounding the automated data conversion procedures (sections three through ten of this
document) is a standard procedure that Texas Guaranteed team members implement for
converting all existing AdvanTG Web II institutions. The details vary depending on whether
the institution is a new or existing customer, plus whether the existing institution is an LBW
Phase 1 user or uses AdvanTG Desktop software.

Note: Because servicers have multiple schools as trading partners, each school must
be converted to AdvanTG Web prior to converting the parent servicer institution.
Consult Appendix A – Institution on page 83 for information about the initial institution
conversions.

Customer data conversion includes procedures for
• TG guaranteed loans stored on the mainframe systems
• Existing Loans By Web (LBW) Phase 1 Customers
• Existing AdvanTG Desktop customers
• Servicers (with multiple trading partners)

TG Subprocesses
Multiple TG Subprocesses perform automated and manual steps within the AdvanTG Web
customer conversion effort.

Key Subprocesses involved with the AdvanTG Web Customer Conversions:
• BIT – Customer Services, Business Integration Team
• BIT-Tech – Technical Group of BIT that performs the "lion's share" of the data validation

activities using LBW, AdvanTG Desktop, database utilities, and AdvanTG Web II
software.

• DEV - AdvanTG Web Testing Team performs some of the data conversion operations
using the Customer Conversion Utilities, SQL queries, and a few manual procedures.

• CONS – Customer Services, Team Consultants, who work directly with TG customers
during the conversion procedures.

• PSG – Customer Services, Product Support Group
• SEC – Technical Services, Administration (Information Security Analysts)
• TS – Technical Services, (NSM) Network System Management
• ADS – Application Development and Support

Note: Customer Conversion activities done by the AdvanTG Web Development team
will gradually transition to the ADS group, as more and more institutions convert to
AdvanTG Web II.
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Conversion Activities Notation

Procedure Notation
Throughout Section 2 – Customer Conversion Overview, beginning on page 19, and in
Appendix B – Customer Conversion Checklist (pages 87 to 94), each portion of customer
conversion effort is numbered. The 79 step numbers in Section 2 and Appendix B correspond
to the Customer Conversion procedures performed by the TG Subprocess teams.

Some of the 79 steps use the Customer Conversion Utilities (Section 4 – Customer Conversion
Utilities on page 36) to perform data conversions. Other steps require manual operations, SQL
database queries, specific software utilities, the LBW application, and the AdvanTG Web II
application.

Schedule Notation
Implement Day (Day 4) – The day when a customer's access to AdvanTG Phase I and LBW is
removed and user IDs for AdvanTG Web II become active. CONS personnel will be onsite to
provide training, customer support, and distribute customer user IDs and passwords.

The three business days prior to the implementation day are called Day 1, Day 2, and Day 3.
Day 4 refers to that day the institution begins using AdvanTG Web II.

Examples:  If Implementation Day is scheduled for a Thursday; Day 1 is the prior Monday.
If Implementation Day is scheduled on for Wednesday; Day 1 is the prior Friday.

Customer Notation
Throughout the TG customer conversion procedures, most steps will apply to all customers.
When the TG customer conversion step refers to only LBW phase 1 customers, AdvanTG
Desktop customers, or other specific customer subgroups, the notation
[customer data], reads (open bracket, customer data, close bracket) displays at the start of a
customer conversion step.

Examples:
1. [AdvanTG Desktop] BIT-Tech will verify for AdvanTG Desktop users…

20. [LBW Customers] DEV will change the LBW school status from
Transition to…
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Conversion Activities Schedule

Schedule Overview
There are six key time periods of activity during the AdvanTG Web customer conversion
effort. The major activities are summarized in Table 2: Customer Conversion Activities
Schedule. For a brief checklist of the 79 conversion steps, refer to Appendix B – Customer
Conversion Checklist on page 87.

Table 2: Customer Conversion Activities Schedule

Time Period
Key

Groups Major Conversion Activities
1-2 weeks
before Implementation

CONS
BIT
BIT-Tech

Gather all security information (user IDs, names, rights)
Determine Institution's profile and optional features
Contact institution's trading partners

Implementation Week BIT
SEC
BIT-Tech

Setup Institution's profile and optional features
Setup or import User IDs into AdvanTG Web security
Setup User ID roles and capabilities
Review institutional profile and user roles

Day 1
(see notation above)

Customer

PSG

Submits final applications, CTs ,and EFT approvals
Export final response files, print necessary reports
Request Initial Load Extract jobs at COB

Day 2 TS-NSM
BIT-Tech

Disable institution TG mailbox
Extract institution loan history from mainframe (Section 6)
Receive AdvanTG Desktop database
Request Phase 1 database from ADS
Prepare current database
Create CT import file (Section 5)

Day 3 DEV

BIT-Tech

Disable institution access to LBW
Perform LBW conversion (Section 5)
Validate LBW Conversion results
Import CTs extracted from desktops on Day 2 (Section 6)
Validate CT record counts
Verify loan record count
Post Initial Load (Day 2) file to BPLM (Section 7)
Flag loans and CTs as "exported" and backdate receive
dates (Section 8)
Decrypt and rename institution response files (Section 10)
Update TG WareHouse for non-TG and Alternative Loans

Day 4
Implementation Day
”Go-live” date

SEC
DEV
CONS

Disable Phase I portal
Activate AdvanTG Web II User IDs
Redirect LBW students to AdvanTG Web II
Provide access (passwords, User IDs) to customers
Check Internet Browser and proxy server settings
Provide training, and support to customers
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Preliminary TG Customer Conversion Activity
When an institution is not currently using TG Solutions & Tools (AdvanTG desktop or
AdvanTG Web Phase I), begins using AdvanTG Web II, any loans that TG may have
guaranteed for the new customer institution, are loaded into AdvanTG Web II using the
procedure found in Section 7 – Initial Load Process.

When an institution is currently using TG Solutions & Tools (AdvanTG desktop or AdvanTG
Web Phase I, Loans by Web), begins using AdvanTG Web Phase II, their AdvanTG database
loans and change transactions need to be converted to AdvanTG Web Phase II.

One to Two Weeks Prior to Implementation Day
Most of the TG Customer conversion effort, during the two weeks prior to implementation,
involves assessing customer needs, documenting user security information (user IDs,
passwords, names, AdvanTG Web II roles), and working with customer staff who will perform
key Implementation Week actions.

Procedure: Actions Performed During the 1-2 weeks prior to implementation
1. Customer Service Consultants (CONS) interview staff for information about:

— Institution infrastructure (browsers, network bandwidth, number of PCs)
— User names, user roles, and related information for TG security forms
      (See Table 17: User Roles for Schools and Lenders on page 78.)
— Conversion details (implementation date, recovery plan, contact information, etc.)
— Training and support needed for the number of PCs and institution users
— Institution staff that perform tasks on the day the Institution begins production work
— LBW features/URLs this institution wants to use
     (See Table 4: Institution LBW Features and Types of URLs on page 22.)
— Users who want to use the LWC (Letter Writing Component)
— Names of institution's business partners
     (non-TG business partners involved with Alternative Loans and non-TG guarantees).

2. CONS receives new security information such as user ID requests, names, rights. It
reviews, approves, and sends the requests to Business Integration Team (BIT).

3. CONS determines the Institution's profile, LBW features, and any optional URLs.
Once finished, it faxes this information to BIT.

4. CONS determines the Loan Start Date and Loan Statuses (see step 26 on page 23)
to be used for this institution when the Initial Load-Loan Extract process is run on Day 2.
Email this information to the address BITREQUEST@TGSLC.ORG

5. BIT performs several actions for user security:
• Verifies security information for new users
• Identifies user roles for lenders and schools per the Consultant Checklist
• Determine each user's access to Applications, Loans, and Reports functionality in

AdvanTG Web
• Forwards the new user ID requests to Technical Services – Administration (Security).

6. BIT-Tech contacts the institution's business partners and briefs them regarding the
Institution's new TG Warehouse Post Office Protocol 3 (POP3) mailbox; used for receiving
and transmitting CommonLine files. BIT-Tech also requests any public security keys that
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need to be added to the TG Warehouse per Consultant Checklist.
(This is needed only for an institution's Alternative Loan process.)

Caution: Customers must understand that exchanges with non-TG business
partners via POP3 (that is, non-TG guarantees or alternative loans), must be
completed prior to the week of implementation, since their institution's
POP3 mailbox address will be changed to the AdvanTGWeb
[Tgcommonline@tgslc.org] mailbox, once Implementation (Day 4) begins.

7. [AdvanTG Desktop] CONS determines estimated AdvanTG Desktop database filesize and
method for the institution to transfer their AdvanTG Desktop databases to TG. (Institution
sends database to ADS, which sends the files to BIT-Tech.)  

8. CONS will develop a plan for institution training and support (based on number of users
and number of PCs).

9. CONS works with the customer to determine the Implementation Date (Day 4) for this
institution. CONS otains names and telephone numbers of staff who will participate in the
customer conversion actions.

10. CONS works with the customer to determine recovery procedures to use if the conversion
effort runs into any significant problems.

11. [Existing] CONS submits a request to Application Production Support to request a folder
for a customer pending disbursement report.

12. CONS verifies completion of the Consultant Checklist. For each institution that plans to
send TG AdvanTG Desktop Paradox database files, CONS forwards the information to the
BIT-Tech team.

13. [New LBW Users] BIT defined Institution's profile and optional LBW features using the
AdvanTG Web Institution Administration GUI. Mark complete on Consultant Checklist.
BIT creates the new institution in the AdvanTG Web II system using the AdvanTG Web
Institution Administration GUI. This interface permits you to define this institution's
characteristics and make references to parent institutions (another school, lender, or
servicer). (See Table 3: Overview of Institution Profile Areas on page 22.)

14. [New Users] CONS reviews, approves, and sends all new user security requests to BIT.

15. [New Users] BIT provides new institution security information to Technical Services –
Administration (Information Security Analysts).

Caution: Security must have User Requests at least one week prior to the institution's
implementation day.

16. [New Users] Security (SEC) establishes the user accounts, passwords, and relates them to
the TG institution using TS internal procedures.
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Note: Security Administration instructions and procedures are located in the folder -
Corpfile2\IRM-Security Administration\SA-INST\External
Customers\Instructions for External Customer Requests.doc. For
additional information about Security Administration’s instructions, contact Lucille
Santillo (Information Security Analyst) at (800) 252-9753, extension 4904.

17. [Phase I users] Security (SEC) exports a file containing an institution's Phase 1 security
information to be loaded directly to the AdvanTG Web II LDAP database and sends it to
the AdvanTG Web development team.

The exported security file contains:
• User Name
• Password set to a default value "welcome"
• Department
• Division
• Institution Department of Education (DOE) ID
• Access to RTA (Real Time Access) mainframe ID and password

18. [Phase I users] The AdvanTG development team (DEV) uses scripts to directly load
Phase I security information into the AdvanTG Phase II LDAP security servers. (See LDAP
and iPlanet Directory Server in the Terminology section on page 11.)    

19. [New Users] SEC returns user IDs and passwords to BIT.

20. BIT defines User ID roles using AdvanTG Web Modify AdvWeb User Profile. Based on
the Consultant Checklist submitted by the customer and CONS, BIT defines user's
authority for specific AdvanTG Web II functionality. (See Table 17: User Roles for
Schools and Lenders on page 78.)

21. BIT notifies BIT-Tech and forwards the request forms for verification.

22. [New Users] BIT distributes the user IDs and passwords to the CONS to hold for the
customer until Implementation Day (Day 4 – “Go-live”).

23. BIT-Tech verifies the institution profile and user roles defined for this institution's users
based on forms sent by BIT.
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Institution Profile and User Profile Information

Institution Profile Maintained by BIT
Depending upon the institution, use of Loans by Web features, and optional URLs that point to
specific locations on the institution’s Internet site, the TG BIT (Business Integration Team)
maintains and updates Table 3: Overview of Institution Profile Areas information in the
AdvanTG Web II system using the AdvanTG Web Institution Administration GUI.

Table 3: Overview of Institution Profile Areas
Section Profile Information for an INstitution

Global Defaults • Loan Application Defaults
• Graduation Dates
• Loan Periods
• Disbursement Dates

Preferred Lenders • Add/delete Preferred Lenders
• Sort and display Preferred Lenders

Records Purge Criteria • Applications
• Loans
• Change Transactions
• Roster Files (School)
• Roster Files (Lender)
• Demographic Information
• Import and Receive Results
• Reports

CommonLine • CommonLine Profile
• CommonLine Routing Information

Loans By Web Information
(See Table 4 for details)

• School LBW Profile
• URL Information

Security • User Privileges in AdvanTG Web
• Adding, Deleting, Changing User Rights

LBW Features and Optional Web Pages

Table 4: Institution LBW Features and Types of URLs
Types of URLs LBW Features

• Institution Logo
• Home Page
• Entrance Counseling
• Fact Sheet
• Electronic Signature

• LBW processing for MPN Loans
• LBW processing for PLUS Loans
• TG's LBW/Batch import process
• Using LBW strictly for Fast Track Funding
• Want to use Entrance Counseling?
• Students can do certification requests for Stafford loans
• Parents can do certification requests for PLUS loans

Note: Institution LBW features/URLs are stored in the AdvanTG Web II database
tables DInstitutionFeatr and DinstitutionURL.
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TG Conversion Activity – Implementation Week

Day One (three business days before "Go-Live")
Most of the activity done today revolves around the institution's staff completing its final work
in existing AdvanTG and LBW applications.

Caution: AT NOON ON DAY Two, ALL WORK MUST BE COMPLETED BY THE
INSTITUTION'S USERS.

Procedure: Day One Activities
24. Customer submits final applications, CTs, and EFT approvals (lenders). Lenders send final

approvals for which they want to receive responses. Institutions receive responses from
previous batch jobs.

Caution: Lenders MUST NOT send any more approvals after this transmission,
because they will not receive responses for these records in AdvanTG Web II.

25. Customer exports response files from AdvanTG into their FAMS or LMS and prints any
necessary reports (normal procedure).

Caution: After the send/receive and export/printing, the institution MUST NOT work
any records or create new records (data entry or importing) in AdvanTG Desktop.

26. BIT-Tech requests an Initial Load Extract mainframe job to obtain guaranteed loans for this
institution and put the information in CommonLine format. (See Section 6 – Export/Import
Desktop Change Transactions on page 52.)
Using REXX TSO panels, specify Institutions, Loan Status, and Loan Period
Begin Date (0-24 months).
Loan Status, and Loan Period Begin Date are taken from the Consultant Checklist.

Specify request for AdvanTG Web Setup and Database Load.
On the request form, check: Next Business Day and Extract, Update, Utility, and
PAWD900R (FTP file transfer) jobs.

Note: Submit this request to Production Control at the Close of Business on Day 1.
This mainframe job must be run after all batch processes complete, about 6 a.m. on
Day Two.
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Day Two (two business days before "Go-Live")
Most of the activity centers around BIT-Tech and the DEV team converting customer data into
formats that AdvanTG Web II can easily process into it's database. Most of the data validation
procedures are found in Steps 43, 49, 51, 52, 55, 57, 60, 62, and 64 of Section 2. The
automated procedures are described in Section 4 – Customer Conversion Utilities on page 36.

(Activities that must Finish before 12:00 p.m. Noon – Day 2)

Procedure: Day Two Activities Prior to Noon
27. BIT-Tech ensures that the Loan Extraction Job runs on mainframe and puts data into

CommonLine format. The final step transfers (using FTP) the Initial Load file from the
mainframe to a working production directory folder.

Note: BIT-Tech saves this file in a unique dataset on the mainframe so that it is sent
to AdvanTG Web II production server at the appropriate time.

Note: These loan results have the status set to "exported" and the receive
timestamps set-back by 24 hours. (See Section 8 – Mark Exported Data on page 71.)

28. PSG verifies that the customer receives FINAL batch of responses and notifies BIT-Tech.

Note: EFT Approvals. This data will need to be re-entered into AdvWeb Phase II or
Online Access. The institution should run a report to find unapproved transactions
before data conversion starts.

29. PSG verifies that the customer exports FINAL files into their FAMS or LMS and prints
necessary reports. PSG notifies BIT-Tech.

Caution: AdvanTG data (disbursement rosters, non-TG guarantees, alternative
loans, processed changes) will be converted and inaccessible to Phase I customers
after conversion. AdvanTG Desktop customers can access their databases for read-
only inquires.

 (Activities that must Finish by the Close of Business – Day 2)

Procedure: Day Two Activities After 12:00 p.m. Noon
30. [AdvanTG Desktop] PSG checks that all activity has stopped and all users are logged out

by noon. Customer sends Desktop Paradox database to ADS [cb1, chng, and indexes]
using appropriate method (based on filesize):
• (filesize < 2 MB) Use WinZip compression & email to tgtesting@tgslc.org
• (2 MB < filesize < 15 MB) Save to an Internet Drive and download to TG.
• (filesize >15 MB) Use CD-ROM burner and send database using TG's FedEx account

Alternative: Save to an Internet drive if no CD burner is available

Caution: Once the institution's AdvanTG Desktop database is sent to TG, the
institution should not import or transmit any addtional AdvanTG data.



Customer Conversion User Guide v2.2 Section 2 – Customer Conversion Overview

Adding Revisions - 12/17/2002 25 TG Confidential and Proprietary Information

31. BIT-Tech uses the UserList INI Utility (developed by Mitchell Reid) to shut-down
the customer's Phase 1 mailbox access, once PSG has notified them that all customer
activity is completed.

Note: Customers must understand that exchanges with non-TG business partners
via POP3 (that is, non-TG guarantees or alternative loans), must be completed prior
to the week of implementation, since theinstitution's email address will change to the
AdvanTG Web II mailbox.

Caution: Once this is accomplished, the school CAN NOT transmit until DAY 4 -
Implementation Day. Desktop AdvanTG institutions can still be able to access their
AdvanTG database for read-only inquires.

32.  [Phase 1] BIT-Tech requests institution database from Application Production Support.
(a) Submit ServiceCenter Problem Ticket to request a copy of the institution database.
(b) Assign the ServiceCenter ticket to Appl Prod Support.
(c) In description field, type this text:
      “AWII Conv. Pdox db – Cb1 Chg only.”

33. BIT-Tech creates a folder structure on a TG Corporate Server for conversion data (see
Figure 25: Moray Server – Phase 1 Mailbox and Corporate Server on page 81):
(a) Create a folder for this institution on TG's corporate server:
      CorpFile2\\Everyone\AdvanTG Web Conversions\<Institution Name>
(b) Create subfolder for the Original copy of the AdvanTG Desktop CB1 CHNG database:
      …\AdvanTG Web Conversions\<Institution Name>\Pre-Conversion

(c) Create subfolders to hold reports, logs, and record counts.

34. [Phase 1] BIT-Tech receives notification that the institution's current production database
is available. Unzip files first as needed. Copy and paste customer files to the
C:\advantg\data folder on local PC.

Note: Phase 1 institutions to do not require any software upgrade. These customers
should already be running Build 5.1 of the Desktop AdvanTG Desktop software.

35.  [AdvanTG Desktop] BIT-Tech prepares the desktop database using three procedures:
(a) Run Database Repair procedure.
(b) Compress the customer files with the Database Packer.
(c) If necessary, upgrade the AdvanTG desktop software to Build 5.1
(d) Create a Updated DB subfolder under the institutional folder created in step 33.
      Place results of the repaired and compressed database into the Updated DB folder.

Repair DB Procedure
Using the local PC on which the customer's AdvanTG files are temporarily stored:
(i) Select the command from the menus Start » Programs » TGWorks » Database Repair.
(ii) Login to database with the institution's UserId=Admin and Password=Admin.
(iii) Click Select All.
(iv) Click Verify and Rebuild.
(v) Scroll through Table listing and verify that all tables are listed as OK.
(vi) If not, repeat step iv and step v until all tables show a status of OK.
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Compressing DB Procedure
(i) Using Windows Explorer, access the Database Packer by navigating to the folder/file
     named — C:\advantg\bin\packer.exe
(ii) Double-click the file to start the Database Packer.
(iii) Highlight the desired database in the left-side pane.
(iv) Select the Compact All Tables command from the Options menu.
(v) Exit or Close the Database Packer once file compression is done.

AdvanTG Desktop Upgrade Procedure
(i) Reference CONS Consultant Checklist to determine customer's current AdvanTG
    desktop version. Phase I users should be working with Build version 5.1.
(ii) Refer to AdvanTG 3.0 Build 5.2 installation instructions.doc for correct procedures to
      update the software module.
(iii) Copy the modified AdvanTG program file (Advantg.exe—dated 10/08/02) to your
       desktop from the TG corporate server folder —
       \\CorpFile2\Groups\Everyone\Andi\Modified Export CT

Save Repaired Database Procedure
(i) Create a Updated DB subfolder under the institutional folder created in step 33 with
     the name:
     …\AdvanTG Web Conversions\<Institution Name>\Updated DB
(ii) Copy the repaired and compress Desktop database from C:\advantg\data to
     …\AdvanTG Web Conversions\<Institution Name>\Updated DB

Note: The AdvanTG program file (advantg.exe) is required to create the modified
ChangeSend file containing customer change transactions. The procedure to create
this CT file happens in step 37 and the additional file information is described in
Table 12: Extra AdvanTG Web II Information in Change Send File on page 54.

36. [AdvanTG Desktop] ADS archives AdvanTG Desktop databases received by BIT-Tech at
the close of Day Two business.

37. [AdvanTG Desktop and Phase 1] BIT-Tech exports Change Transactions from the
modified AdvanTG Desktop:
(a) Using desktop AdvanTG, log in as conversion institution.
(b) Select the Change Transaction command from the Export>>Change Transactions
      cascading menus.
(c) Select the "Transmitted 8s, 9s, and 10s" option.
(d) Press OK.
(e) Save the file to a standard location. Currently BIT-Tech uses the corporate folder:
      G:\Everyone\AdvanTG Web Customer Databases\<institution name>
(f) Verify the number of records to export is the same as the number of Transmitted
      @1-8s, @1-9s, and @1-10s records listed in the Change Maintenance window.
(g) Record the number of records for reference later in the Customer Conversion effort
      (see Step 54 on page 29).
(h) Notify the DEV Testing Team member who will run the Import CT process in Step 54.

Note: If you open the exported CT file in a text editor, you will see additional
information after the normal record terminator of each ChangeSend record. This file
becomes a working file used by the CT Import option under the
Customer Conversion utilities.
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Day Three (one business day before "Go-Live")

Note: DEV Testing Team converts pending certifications and pending change
transactions from the Desktop AdvanTG database and TG loans via Initial Load from
TG's mainframe during Day Three.

38. [LBW Customers] DEV modifies the LBW Internet page URL to redirect students to an
"Outage" Internet page, while the customer conversion is in progress. (On Implementation
Day, they will be redirected to AdvanTG Web II site URL).

39. DEV Testing Team verfies using the https://lbw.tgslc.org URL that LBW
Phase 1 users are routed to to the outage page.

Note: Neither the Institution or students will have LBW access during Day Three.

40. DEV Testing Team verifies the institution to be converted is marked Complete. Team
member examines the Completion Flag=1 field in the AdvanTG EInstitution table
for this institution's DOE ID.

Note: DEV Testing Team ensures that the nightly Institution Synchronization job ran
on the mainframe and the updates were performed on the AdvanTG Web database.
See Section 3 - Nightly Institution Synchronization for additional details about
AdvanTG Web tables and fields that are updated.

41. DEV Testing Team checks for the Initial Load (from Loan Extraction Step 27) and the
Import CT (exported from the AdvanTG Desktop in Step 37) files are available to begin the
conversion process.

42. DEV Testing Team determines the production server running the Customer Conversion
Utilities is functioning properly by using the URL address.
Example: http://ads-vnrxg:7001/importdata

43. [LBW Customers] DEV Testing Team uses the SQL queries in Appendix D – Customer
Conversion Validation Queries on page 102 to determine the record counts (Table 21) for
the institution to be converted.
Current LBW production database information:
- LBW School URLs and LBW Preferred Lenders
- MPN Applications and MPN Certifications
- PLUS Applications and PLUS Certifications

44. DEV Testing Team announces to TG they are ready to begin data conversions. DEV next
sends an email to BIT Team Members and other conversion team members that the
institution's data conversion is beginning.

45. DEV Testing Team starts the production server (Step 42) used to perform the institution
data conversion. For example: type the Internet Explorer address:
https://ads-vnrxg:7001/importdata

46. [LBW Customers] DEV Testing Team uses the Customer Conversion Utilities to change
the institution from a status of Phase 1 to Transition. This change is reflected in the
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TLBWINST AdvanTG Web database table. Group uses the SQL query in Table 22 to
validate the status change.

47. [LBW Customers] DEV Testing Team verifies (with the address
https://lbw.tgslc.org ) that this LBW institution's users are routed to an outage
page.

48.  [LBW Customers] DEV Testing Team converts LBW information to AdvanTG Web II.
Runs the Customer Conversion Utilities to convert loans, certifications, basic institution
information, URLs, preferred lenders, pending award certifications, and master
demographics to AdvanTG Web data.

49. [LBW Customers] DEV Testing Team records the LBW conversion record counts
displayed by the Customer Conversion Utilities and uses the query in Table 22to determine
the total number of MPN/PLUS loans and certifications. See Section 5 – LBW Conversion
Procedures for details about performing the conversion and obtaining record counts.

50. [LBW Customers] DEV Testing Team notifies Conversion Team members and provides
record counts from the LBW conversion step.

51. [LBW Customers] BIT-Tech validates the conversion of loans and certifications from
AdvanTG Phase 1 to Phase 2 database.

(a) Validate the converted record counts match the institution's data in LBW.
Check for number of certification records. (https:\\adv-prod.tgslc.org)
(i) Login to AdvanTG Web Phase 1.
(ii) Click Web or Phone Certification - TG Admin.
(iii) Click the Certification Information link
(iv) Type the nine-digit School DOE ID (for example, 003545000).
(v) Click Submit Query.

(b) Randomly select 10 certification listings using the Phase I LBW production data base,
that fall within the Loan Period Begin Date and Certification Date
specifications described in the next note.
[Ensure these certifications cover most common MPN and PLUS certification types!]

(c) Verify in the AdvanTG Web II database the LBW records were loaded
URL is (https:\\advprod.tgslc.org)
(i) Select Application Status Report from the Reporting Page that displays after
    AdvanTG Web displays the home page (after you login).
(ii) Scroll to bottom and deselect all Application Status options except for LBW
   Certification (L - status).
(iii) Compare record counts from AdvanTG Web II Application Status Report and utility
       count provided by DEV using the Data Conversion Utilities.

Note: The date criteria for selecting LBW loan certitfcations for verification:
Loan Period Begin Date is not later than one year and a day AND
Certification Date is less than 2 years old.
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Note: The AdvanTG Web production URL will ultimately be changed to
https:\\advweb.tgslc.org

52. [LBW Customers] BIT-Tech reviews the institution's converted data for the previously-
selected 10 (random) certifications.
(a) Navigate to the List Applications page in AdvanTG Web II.
(b) List all applications with an L (LBW Conversion) Loan Status Code.
(c) Check that mandatory data fields for the MPN or PLUS certifications exist (see
Table 10: Mandatory Fields for LBW Certification on page 48.)

Caution: If your selected SSN certification is not listed, it was because a second
certification has been created and guaranteed in Phase I during the same date range.
This can be verified by logging into the Phase I LBW System and referencing the
History for the specific Social Security Number.

53. [LBW Customers] BIT-Tech sends email notification to Robert Blackard that the LBW
data conversion is complete. They provide the institution's name, Department of Education
ID (DOE ID), and state name.

54. [AdvanTG Desktop] DEV Testing Team imports into AdvanTG Web, the Change
Transactions (CTs) extracted from the modified AdvanTG Desktop software on Day 2.
(See Step 37 on page 26.) See Section 6 – Export/Import Desktop Change Transactions for
additional details.

55. [AdvanTG Desktop] DEV Testing Team records the number of CTs imported by the
Customer Conversion utilities and uses the two queries in Table 22 to determine:
(a) Total number of @1-02 Change Transactions
(b) Number of @1-08, @1-09, and @1-10 detail records

56. [AdvanTG Desktop] DEV Testing Team sends an email to the Conversion team members
with the Import CT record count.

57. [AdvanTG Desktop] BIT-Tech validates that the number of CTs imported into AdvanTG
Web II matches the record counts.
(a) Verify the Import CT data record count with the AdvanTG Web II Change Transaction
Transmission Log.
(b) Note any discrepancies and send an email notification to the BIT team lead (Chuck
Ramos) and Development Team/Application Support lead (Bill Roush).
(c) Review institution's imported change transactions for matches by randomly selecting
@1-8, @1-9, and @1-10 records in AdvanTG Web II and comparing with desktop data.

Verify the Import CT Data
(i) Using Phase II, run the Change Transaction Transmission Log.
(ii) Verify that the number of records matches the number of records exported in step 37 on
      page 26.
(iii) Note any record count discrepancies in the second step.

Notify Team Leads:
Send an email notification to BIT team lead (Chuck Ramos) and Development
Team/Application Support lead (Bill Roush).
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Review institution's imported change transactions for exact matches:
(i) Display the List CT window in Desktop AdvanTG.
(ii) Note any discrepancy between the Change Transaction Transmission Log, exported
      record counts, and the List CT window.
(iii) Randomly select an @1-8, a @1-9 and a @1-10 record (if available) and compare the
       data in AdvanTG Web Phase II with the data in the AdvanTG desktop from which the
       import was derived.

Note: Verify that each change transaction type (that is, @1-09 Pre-Disb Date
Change) is the same in both AdvanTG systems.

58. [Large Loan Guarantee Institution] DEV Testing Team runs the Split CL Response File
utility to break-up the institution’s single file into small segments that the AdvanTG Web II
B2B Server can efficiently process.

59. DEV Testing Team examines the CL Response (plus any sub-files) and send results to the
BIT lead.
(a) Examine the CL Response File and sub-files for their record counts.
(b) Place the file(s) in the AdvanTG Web II \\moray\be_bplm folder.

60. DEV Testing Team ensures number of loans inserted into AdvanTG Web tables equals the
CL Response file record counts reported by the Customer Conversion Utitlities. Run the
two SQL queries in Table 22 to determine the number of loans and to detect any file
parsing errors.

61. DEV Testing Team sends number of loans/record counts in email to Conversion Team
members.

62. BIT-Tech reviews institution's initial load (guaranteed loans)in AdvanTG Web II. by
verifying the record count on the Receive Results Report.  
(i) Navigate to the Receive Results Report page using the Internet pages
     Menu » Reporting » Transmission Reports » Receive Results Report.
(ii) Keep the date range the same as the current date.
(iii) Click OK.
(iv) Examine to the Total number of records listed at the bottom of the report.

Note: The number of loan records in AdvanTG Web II is nearly the same as the
number of records extracted. There may exist a few discrepancies due to improper
information on the TG mainframe.

63. DEV Testing Team uses the Customer Conversion Utilities to mark all LBW loans and CTs
as "Exported" and revises the receive dates in the affected AdvanTG Web II database
tables by 24 hours.

64. BIT-Tech reviews the marked change transactions and loans. To verify the record count:
(i) Go to Export Responses page
(ii) Verify the number of CL4 records available for export is zero.
(iii) Attempt to do an Export using the date range (use today's date in the To and From
       fields). The result should be No records exported.
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(iv) Go to the Loan Response report. Run the report with the Refresh option selected
       and the current date as the To and From dates. No records should be displayed.

Note: If any significant problems are encountered, the Customer Conversion Utilities
can also unmark (undo) the marking of exported data. (See Section 8 – Mark
Exported Data, Troubleshooting on page  73.)

65. [LBW Customers] DEV Testing Team uses the Customer Conversion Utilities to change
the institution from a status of Transition to Phase 2. This change is reflected in the
TLBWINST AdvanTG Web database table. Verify the results using the SQL query in
Table 22.

66. [LBW Customers] DEV Testing Team verifies (useing the https://lbw.tgslc.org
address) that LBW users are routed to the Adv Web Phase II system.

67. DEV Testing Team sends an email to the AdvanTG Web database administrator, requesting
that they can run the "Statistics Update" command.

68. [Existing, as needed for AdvanTG Desktop and Phase 1]
BIT-Tech posts most recent response files and renames to AdvanTG Web standards:
(a) Access customer's production mailbox (Moray server) using the <MailBox ID> found
      in Appendix A – Institution Information.
(b) Copy response files to corporate server folder:
… \AdvanTG Web Conversions\<Institution Name>\<MailBox ID>
(c) Use the Decrypt Utility to convert data to plain text and save the decoded response
      files in Conversion-II folder.
(d) Rename files to conform to AdvanTG Web II file naming standards (as needed)
(e) Drop file copies in the same BPLM so the CMLN files can be moved to the proper
      server. \\Moray\BE_BPLM

Note: The <MailBox ID> for this institution, used to locate the Phase I response
files and as a label for the storage folder, can be found in Appendix A – Institution
Information on page 83. The <MailBox ID> is the hexidecimal equivalent of the
institution's 6-digit DOE ID.

Caution: Follow the AdvanTG Web Renaming procedures described in Section 10 –
Renaming AdvanTG Phase I Files on page 79), to ensure proper processing of the
CommonLine Response Files.

69. [Existing]BIT modifies the production TG Warehouse Tables (CommonLine and
ConnecTG) to send all responses for this institution's associated trading partners to the new
AdvanTG Web II email address:
(a) Update line 5 of the CommonLine table to include ADWB in place of ADTG.
(b) Update line 4 (RRD line) of the ConnecTG table to be ADVWEB rather than the
      ConnectTG mailbox identifier.

Note: The ConnecTG table will automatically synchronizes with the Electonic School
Report (ESR) profile page.
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70. DEV Testing Team archives all intermediate customer conversion files used during Initial
Load and CT Import. See Section 6 – Export/Import Desktop Change Transactions on page
53 and Section 7 – Initial Load Process on page 69.  

71. BIT-TECH SIGNS-OFF ON IT'S REVIEW OF ALL CONVERTED CUSTOMER
DATA.  

72. The BIT lead/backup (Chuck Ramos) sends an email to the Customer Conversion email
group, that a review of this institution's converted data is complete.

73. Technical Services AdvanTG Web Database Administrator (DBA) runs statistics command
(Run Status) after each institution conversion to optimize future production queries.

Note: Running these statistics is essential to ensuring that AdvanTG Web creates
optimal queries during production hours.

74. BIT-Tech creates a TG Warehouse BASE profile for the institution.

Caution: This step MUST NOT be done until the Mark Export Data procedure is
completed. See Section 8 – Mark Exported Data on page 71.   

Implementation Day (Institution "Goes Live" with AdvanTG Web II)
On Implementation day, access to AdvanTG Web II is provided to the institution and its
students, along with the necessary onsite training and customer support.

Procedure: Implementation Day Activities
75. Security inactivates Phase I user's portal access (before start of business, 8:00 AM) and

activates the user IDs for AdvanTG Web II.  

76. TS – Administration modifies LBW to redirect students to the AdvanTG Web II system for
those schools that have converted to AdvanTG Web II. This is done on a school-by-school
basis.

Note: This forwards requests to AdvWeb Phase II's Complete/Update Application
page if the School has already been converted to AdvWeb Web II. This helps TG to
tell schools that the URL page for students to access will continue to be the LBW's
URL for the next year, but will forward those students to AdvanTG Web II once the
school is converted. This step is required so that LBW knows this school has been
converted to AdvanTG Web II.

77. CONS will be onsite at the school(s) to provide new users IDs and Passwords (when
applicable) at the institution as they being using AdvanTG Web II.

78. CONS proactively checks the Internet Browser and Proxy Server settings for each user to
decrease the number of support calls to the Product Support Group. (See Appendix E –
Internet Browser Settings on page 104 for settings and troubleshooting information.)

79. CONS provides training and initial customer support.
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Note: There may be other mechanisms available to get the data from new institutions
as well, particularly if that institution has a FAM system that supports Commonline.
However, these conversions will be handled on a case-by-case basis.

Servicers
Before a servicer is converted to AdvanTG Web II, all of its trading partner institutions
serviced by that servicer must be first converted to AdvanTG Web II. Only then, can the
servicer institution be converted to AdvanTG Web II.

Caution: In addition, the Institution tables in AdvanTG Web II must be set-up
properly using the Institution Administration GUI, in terms of the servicer relationship
between the institutions.

Note: When a servicer is converted to AdvWeb Phase II, the Initial Load Utility may
have to be run for each serviced institution. However, if the servicer has already set
up all loans to contain the servicer information, then the initial load program can be
run just for the servicer.
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Section 3 - Nightly Institution Synchronization
To keep AdvanTG Web II institution (schools, lenders, and servicers) information
synchronized with the TG mainframe systems, a nightly job is run on TG's mainframe. Each
evening, a mainframe job will extract institution data from the Program Support Process
System and create a file with the information displayed in Table 5: Nightly Institution
Synchronization File. This file is automatically sent (FTP) to the AdvanTG Web II WebLogic
server, parsed into individual institution records, and two AdvanTG Web II database tables are
updated.

WHERE DOES THIS PAGE GET SENT TO

Procedure
Procedure: Nightly Institution Synchronization Job
1. Each evening, a mainframe job will extract institution data from the Program Support

Process System that is maintained by CAO team.
2. The fixed-length, 179-character file is sent to the AdvanTG Web Production Application

server which also is running the BPLM process and B2B Server.
3. The BPLM Sever sends the file to the B2B server, which parses the file and updates two

AdvanTG Web database tables – EINSTITUTION (see Table 6 on page 35) and
DINSTITUTIONFEATR (see Table 7 on page 35)

4. Standard business logic applied during the database updates:
� If the institution ID does exist, the EINSTITUTION database information is updated
with the synchronization file information.
� If the institution ID does not exist, the synchronization file information is added as new
EINSTITUTION and DINSITITUTIONFEATR records.

5. Special business logic applied during the database updates:
� For servicer institutions (Type=O) and DOEID starts with a ‘7’in the nightly
synchronization file, set-up the institution in AdvanTG Web as a lender servicer. If the
institution is already exists in AdvanTG Web as a school servicer, do not overwrite the
institution type code in AdvanTG Web.

Table 5: Nightly Institution Synchronization File
Positions Length Description

1 1 Institution Type
(S-School, L-Lender, G-Guarantor, O-Servicer)

2-9 8 Institution ID
Guarantor – 3 digits, Lender – 6 digits, School – 8 digits

10-49 40 Institution Name

50-84 35 Address Line 1

85-119 35 Address Line 2

120-154 35 City

155-156 2 State

157-165 9 Zip Code

166-175 10 Telephone Number
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176 1 TG Eligibility  (Y-Yes, N-No)

177 1 TG EFT Flag (Y-Yes, N-No)

AdvanTG Web II Database Tables Updated

Table 6: EINSTITUTION Fields Updated with Institution Synchronization File
Not
Null

Database
Field Name

Field
Data Type Size Synchronization File

Field
Size

Yes OID INTEGER 10 System Created

Yes DOEID CHAR 8 Institution ID 8

NAME CHAR 50 Institution Name 40

Yes TYPE CHAR 1 Institution type 1

ADDRLINE1 CHAR 35 Address1 35

ADDRLINE2 CHAR 35 Address2 35

CITY CHAR 24 City 35

STATE CHAR 2 State 2 Char

ZIPCODE CHAR 5

ZIPCODESUFFIX CHAR 4

Zip Code 9
NUMBER
(5 + 4)

OFFICIALPHONE CHAR 10 Phone 10
NUMBER

Yes LASTUPDATEDTIME TIMESTAMP 26 System Created

Table 7: DINSTITUTIONFEATR Fields Updated with Institution Synchronization File
Not
Null

Database
Field Name

Field
Data Type Size Synchronization File

Field
Size

Yes FEATURECODE CHAR 4 TG Eligibility Code (1)
TG EFT Flag (T)

1

yes INSTITUTIONOID INTEGER 10 Institution ID 8

TIMESTAMP TIMESTAMP 26 System Created

Note:
(1) One record will be loaded to DINSTITUTIONFEATR for TG Eligibility code.
(That is, if TG Eligibility code is “YES”, then one record is added in the combination of
FEATURECODE and INSTITUTIONOID. If code is “NO” no record will be added.

(2) One record is loaded to DINSTITUTIONFEATR for TG EFT Flag.
(That is, if TG EFT Flag is “YES” then one record will be added in the combination of
FEATURECODE and INSTITUTIONOID, if code is “NO” no record will be added.)
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Section 4 – Customer Conversion Utilities

Procedures
This area describes the main Customer Conversion Utilities a Texas Guaranteed team member
would use to convert customer institution (school, lender, servicer) loan data. These operations
are described in this section and in additional detail in Sections Five through Nine.

Using two graphical user interfaces (GUI), a TG team member can perform:
• Change the status (Phase 1, Phase 2, or Transition) of an LBW institution
• Convert LBW Phase 1 Loans, Certifications, and School information.
• Import Change Transactions (CTs) produced from AdvanTG Desktop software.
• Split Initial Load file (loans guaranteed by TG) into smaller CommonLine Response files.
• Mark converted loans (with a LoanAppCode = 'L'), Change Transactions, and imported

guaranteed loans as "exported" and reset receive dates by 24 hours from the current date.
• Undo the last operation that marked an institution's loans as "exported".
• Check the TopLink Sequence numbers for a database to ensure operational consistency.

Figure 1: Customer Conversion Utilities
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Change Customer Institution Data Status
AdvanTG Web maintains a database table (TLBWINST) that describes the current status of a
Loans by Web (LBW) institution.

The LBW School Phase statuses are:
• 1 – Current LBW Phase one customer.
• Transition – TG Team members are performing the customer conversion activities

during Day 3 of Implementation week. More specifically, step 40 of the customer
conversion process has started and step 54 is not completed.

• 2 – Customer Conversion of LBW information is complete.

Note: Refer to Section 2 – Customer Conversion Overview, beginning on page 19,
for the 63 customer conversion steps.

Figure 2: Change Institution Phase - Select

Procedure: Changing an Institution's Phase Status
1. Start Internet Explorer browser software.

2. Type this URL to access the Customer Conversion Utilities:
http://<dnsaddress>:7001/importdata/index.jsp
where <dnsaddress> is the appropriate AdvanTG Web environment.

3. Click the Change Institution's Phase… option on the Customer Conversion Utilities
page displays Figure 2: Change Institution Phase - Select.

4. Type the needed DOE ID (Department of Education ID) for the institution (school or
lender), Servicer DOEID for lenders, and the optional Non-DOE Branch IDs if
necessary.
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5. Select the status for this institution from the Change Institution Phase To drop-down list

6. Choose Staging/UAT, Beta, Production, or Production-Staging from the Select
Database drop-down list

7. Click OK.

8. If the institution DOE ID is correct, the Change Institution Phase - Results page displays
(Figure 3). If the school/lender ID is mistyped or invalid, Figure 4: Change Institution
Phase – Institution Not Found displays.

Note: Refer to Appendix A – Institution Information on page 83 for institution DOE
IDs.

Figure 3: Change Institution Phase - Results

Figure 4: Change Institution Phase – Institution Not Found
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Import Loans by Web Customer Information
The Customer Conversion Utilities transfers loans, certifications, and institution information
from the LBW Production (Test) database to the AdvanTG Web database. Clicking the
Transfer LBW School, Certification, and Loan data… option on Figure 1, starts the
conversion procedure.

Refer to Section 5 – LBW Conversion Procedures, beginning on page 45, for detailed procedure
steps and data validation procedures.

Table 8: LBW Conversion – Converted Information
Data Classification Notes

Institution Updates Retrieve institution information regarding contacts, URLs, preferred lenders
and profiles from LBW and update the AdvWeb Phase II database with that
information for a given institution (including accessible institutions—branches,
serviced institutions). This application needs to be run right before conversion
of the institution to get any updates that have been made to LBW.

Institution URLs Converts a school's name, address and 3 URLs
School Counseling
School FAQ (Frequently Asked Questions)
School Test
School homepage

Preferred Lenders Converts a lender's name, address, and homepage URL

Applications Will be overloaded by mainframe receives
Also creates Master Demographic records as it proceeds.
All master demo records are updated from the LBW Borrower table.

Loans MPN and PLUS loans (LBW Stafford table) converted
Will be overloaded by mainframe imports
Also creates Master Demographic records as it proceeds.
All master demo records are updated from the LBW Borrower table.

Certifications MPN and PLUS certifications (LBW Award table) converted as to Applications
Also creates Master Demographic records as it proceeds.
All master demo records are updated from the LBW Borrower table.

Master Demographics Converts Borrower and student demographics
Overloaded by what we receive and import from mainframe

Import Change Transactions
The Customer Conversion Utilities takes the modified ChangeSend file exported from an
institution's Desktop AdvanTG software and populates AdvanTG Web database tables.
Clicking the Import CTs from ChangeSend file… option on Figure 1, will start the
populating the AdvanTG Web tables.

Refer to Section 6 – Export/Import Desktop Change Transactions, beginning on page 57, for
detailed procedure steps and data validation procedures.
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Split Initial Load File
The Customer Conversion Utilities can take a large CL Response file created on the TG
mainframe using the Loan Extraction process (see Loan Extraction Overview on page 61) .
Clicking the Split Initial Load File into Multiple CL Response Files… option on Figure 1,
will create CL Response sub-files that AdvanTG Web B2B server can process efficiently.

Refer to Section 7 – Initial Load Process, beginning on page 66, for detailed procedure steps
and data validation procedures.

Mark Exported Data in AdvanTG Web Database
The Customer Conversion Utilities marks the loans (only those with LoanAppCode=L) and
change transactions as "Exported" and resets the received dates by 24 hours. Clicking the
Mark Exported Data in AdvanTG Web DB… option on Figure 1, changes the information in
two AdvanTG Web database tables. Once this information is changed, the loans converted for
an institution will not list in an AdvanTG Web report falsely.

Refer to Section 8 – Mark Exported Data, beginning on page 71, for detailed procedure steps
and data validation procedures.

Undo Mark Exported Data
The Customer Conversion Utilities can undo the previous database changes made by the Mark
Exported Data in AdvanTG Web DB… option. Clicking the Mark Exported Data in
AdvanTG Web DB… option on Figure 1, effectively executes a database rollback (undo)
operation.

Refer to Section 8 – Mark Exported Data, beginning on page 73, for detailed procedure steps.

Check TopLink Sequence Numbers in Database
Sometimes manual activity in an AdvanTG Web database can create TopLink number
sequencing problems. The sequence numbers are used for the Object Identifiers (OIDs) of the
entity objects in AdvanTG Web.

Once a sequence number is given out to an object to be its OID, it is incremented so that it is
ready for the next created object that is created. Problems arise when the sequence numbers
become less than existing OIDs in the system. This results in SQL exceptions when another
object is given the same sequence number and attempted to be inserted into the database. This
problem can arise by someone resetting the sequence numbers when there are still objects in
the database or by someone inserting records through SQL into a clean database. These records
contain OIDs from whatever database they were dumped out of. The Check TopLink Sequence
Numbers utility obtains the maximum OID for each database table and compares it the
corresponding sequence number to make sure that the sequence number is greater.

Note: This will give testing a tool to run when they do any manual changes or
resetting of the database to make sure it is properly aligned instead of treating it like
an application problem.

Procedure: Checking an AdvanTG Web Database TopLink Sequence Numbers
1. Start Internet Explorer browser software.
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2. Type this URL to access the TopLink Sequence Numbers utility:
http://<dnsaddress>:7001/TopLink.jsp
where <dnsaddress> is the appropriate AdvanTG Web environment.

3. Choose Staging/UAT, Beta, Production, or Production-Staging from the Select
Database drop-down list

4. Click OK. Figure 6: Check TopLink Sequence Numbers - Results displays the AdvanTG
Web database's TopLink Sequence Numbers and tests to see if the numbers are properly set
within all database tables.

Figure 5: Check TopLink Sequence Numbers - Select
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Figure 6: Check TopLink Sequence Numbers - Results
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Section 5 – LBW Conversion Procedures

Introduction
The LBW Conversion Utility is a simple data conversion framework that allows each specific
conversion to be configured in a text file, rather than hard-coded in the programming language.
The data conversion framework is intended to have just the functionality required for LBW
data conversions; it is not a general-purpose data conversion framework. The framework
minimizes the amount of code required for converting LBW data into AdvanTG Web II and
allows the bulk of the data conversion to be configured, rather than coded.

Caution: Prior to running the LBW Conversion utility institution, you must have used
the AdvanTG Web II Institution Administration GUI to establish the Institution
hierarchy (branches, serviced institutions).

See these technical documents for additional details.
• Overview of Customer Conversion Requirements  (David Depinet)

$/AdvWeb/Data Conversion/Data Conversion Requirements.doc

• Design of LBW Conversion Framework (David Depinet)
$/AdvWeb/Data Conversion/Data Conversion Design.doc

• LBW Conversion Logic – Institutions, Loan History, Applications, Certifications, and
Master Demographic (David Depinet)
$/AdvWeb/Data Conversion/LBW Conversions.doc

• Mapping from LBW Database Tables to AdvanTG Web Value Object Variables for
$/AdvWeb/Data Conversion/conversion spreadsheets/All Files

• Data Conversion Class Diagram (Depinet)
$/AdvWeb/Data Conversion/DataConv.mdl

• Journal of Implementation Changes (Alan Hench)
$/AdvWeb/Data Conversion/implementation_changes.txt

• LBW Conversion Instructions (Alan Hench)
$/AdvWeb/Data Conversion/implementation_usage.txt

• LBW Data Conversion Technical Notes (Eric Schneider)
$/AdvWeb/Data Conversion/LBW Conversion Procedure Notes

Caveats

Caution: The information retrieved from LBW will not be sufficient to completely
define an institution in AdvWeb Phase II and the CS – Business Integration Team is
required to complete the definition of converted institutions.

Note: The only Loans by Web demographic information that will be lost, are loans
where the student updated demographics, but has not submitted the application.
These will be lost when the data is overwrititen from the mainframe initial load of
loans. (See Section 7 – Initial Load on page 61.)
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Data Conversion Process Flow

Figure 7: LBW Conversion Flow

The Data Conversion Framework (Figure 7) reads the XML configuration file(s) and creates
appropriate Java Framework Extensions to convert specific LBW database fields into the
format needed for AdvanTG Web code. Each data conversion executes a query against LBW
and for each row in the result set, the data conversion creates an AdvanTG Web Value Object
(for example, SchoolWithURLs, PreferredLenderValue), converts the LBW database
results into fields in the Value Object, and finally calls a sessionEJB to insert or update
AdvanTG Web II database records.

Once the LBW Conversion finishes, it displays:

• Total number of objects successfully converted
• Number of objects that failed to convert

Note: In all conversions, if a non-ED branch ID is given, that ID is used as the non-
ED branch ID for all institutions that are created/updated/referenced during the
conversion. When the institutions imported, used, and updated during the LBW Data
Conversion tests would not interfere with any existing institution records. LBW does
not store non-ED branch information, so none of the LBW database institutions will
have a value for that field. When the production imports are run, the non-ED branch
ID should be left blank to reference the actual institution records in AdvanTG Web II.
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Table 9: Current School LBW Information
MAPNAME XML File LBW School Data Conversion Description
SchoolURLMap URLs, such as entrance counseling and home page
SchoolPrefLenderMap Preferred lenders and their sort order
AppMPNMap 'SF','SU','CS' type applications that are in Ready status ('L')
AppPLUSMap PL' type applications that are in Ready status ('L')
CertMPNMap 'SF','SU','CS' type certifications that are in LBW status ('L')
CertPLUSMap 'PL' type apps that are in LBW status ('L')
LoanHistoryMPNSubMap Create MPN Subsidized loan records, 'SF' type loans that have been

guaranteed.
LoanHistoryMPNUnsubMap Create MPN Unsubsidized loan records, 'SU' type loans that have been

guaranteed.
LoanHistoryPLUSMap Create PLUS loan records, 'PL' type loans that have been guaranteed

LBW Conversion GUI
You can perform LBW conversion operations with the Customer Conversion Utilities shown in
Figure 1: on page 36.

Figure 8: Convert LBW Information – Select



Customer Conversion User Guide v2.2 Section 5 – LBW Conversion Procedures

Adding Revisions - 12/17/2002 46 TG Confidential and Proprietary Information

Procedure: Converting LBW Information
1. Start Internet Explorer browser software.
2. Type this URL to access the Customer Conversion Utilities:

http://<dnsaddress>:7001/importdata/index.jsp
where <dnsaddress> is the appropriate AdvanTG Web environment.

3. Click the Transfer LBW School, Certification and Loan data… option in Figure 1:
Customer Conversion Utilities on page 36.

4. Select the institution type by clicking the School, All Lenders or Lender option
buttons. When you select the School or Lender, the default LBW information types are
selected in the check boxes under the Import Options.

5. Type the needed DOE ID (Department of Education ID) for the institution (school or
lender), Servicer DOEID for lenders, and the optional Non-DOE Branch IDs if
necessary.

6. Click Select All button or select the specific LBW data conversions using check boxes in
Figure 8: Convert LBW Information – Select.

7. Select the desired Source LBW Database using the drop-down list.

8. Click OK. Depending upon the number of records, the utility can run for several minutes
before it displays Figure 9: Convert LBW Information - Results. If the institution DOE ID
is mistyped or incorrect, Figure 10 displays.

Note: This program can take from several seconds to several minutes depending
upon the number of institutional records in the LBW database.
What we are saying is Be Patient!
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Figure 9: Convert LBW Information - Results

Figure 10: Convert LBW Information – Institution Not Found
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Mandatory Data Fields for Validation
As part of the quality assurance effort for the LBW conversion to AdvanTG Web ii, you must
examine a minimum of ten, randomly selected certifications. This permits you to select a
certifications covering the most common types. The MPN and PLUS certifications each have
different required fields, as detailed in Table 10.

Table 10: Mandatory Fields for LBW Certification
Fields MPN PLUS

Borrower First and Last Name X X

Address, City, State, Zip Code, and DOB X X

Enrollment Code
Grade Level Code

X X

Loan Period Start Date
Loan Period End Date

X X

School DOE ID X X

Anticipated Graduation Date X X

Certification Date
Certification Amount

X X

Disbursement Date X X

Loan Type X X

Guarantor ID X X

Process Type Code (GO, GP) X X

Serial Loan Code X

Prom Note Delivery Code X

Quality Assurance for LBW Conversions
You can perform quality assurance on the LBW Conversion using two approaches:

• Use the Customer Conversion Utilities, AdvanTG Web II application, and the LBW
software to validate results.

• Use database SQL queries on the LBW Production and AdvanTG Web database tables to
compare data.

Note: As the LBW Conversion scripts run, they log the Social Security Number (SSN)
and CL Unique ID for each loan/certification object converted. This information is
recorded in the AdvanTG Web II debugging log file found in the folder:
D:\bea\wlserver6.1\logs\advweb-debug.log.

Checking for Duplicate Records in LBW
If you need to run LBW Conversions on loan history MPN and PLUS loans, you must check for
duplicates in the LBW Awards, Stafford (Applications), and History database tables.
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Applications Quality Assurance

Validating the loans and certifications from AdvanTG Phase 1 to Phase 2 database
requires several operations:
• Validate converted record counts match the institution's data in LBW. Check for number of

certification records.
• Randomly select 10 certification listings using the Phase I LBW production data base, that

fall within the Loan Period Begin Date and Certification Date.
• Verify in the AdvanTG Web II database the LBW records were loaded.
• Review the institution's converted data for the randomly-selected ten certifications.

Procedure: Validating LBW Conversion Results
1. Login to AdvanTG Web Phase 1.
2. Click Web or Phone Certification - TG Admin.
3. Click the Certification Information link.
4. Type the nine-digit School DOE ID (for example, 003545000).
5. Click Submit Query.
6. Randomly select 10 certification listings (rather than consecutive records) using the Phase I

LBW production data base, that fall within the Loan Period Begin Date and Certification
Date specifications.

Note: Enure these certifications cover most common MPN and PLUS certification
types!

7. Verify in the AdvanTG Web II database the LBW records were loaded using the URL:
https:\\advprod.tgslc.org

8. Login to AdvanTG Web II.
9. Select Application Status Report from the Reporting Page that displays after AdvanTG

Web displays the home page.
10. Scroll to bottom and deselect all Application Status options except for LBW Certification

(L - status).
11. Compare record counts from AdvanTG Web II Application Status Report and utility count

using the Customer Conversion Utilities.
12. Reviews the institution's converted data for the previously-selected 10 (random)

certifications.
13. Navigate to the List Applications page in AdvanTG Web II.
14. List all applications with an L loan status code.
15. Check that the mandatory data fields for the MPN or PLUS certifications exist.

See Table 10: Mandatory Fields for LBW Certification on page 48.

Note: The date criteria for selecting LBW loan certitfcations for verification:Loan
Period Begin Date is not later than one year and a day. plus theCertification Date is
less than 2 years old.

Note: The AdvanTG Web production URL will ultimately be changed to
https:\\advweb.tgslc.org
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Caution: If your selected SSN certification is not listed, it was because a second
certification has been created and guaranteed in Phase I during the same date range.
This can be verified by logging into Phase I and referencing the History for the
specific Social Security Number.

Database Quality Assurance
Once you have used the LBW Conversion you need to perform some preliminary quality
assurance steps.

Caution: The LBW Conversion quality assurance SQL scripts can be found in Visual
SourceSafe. The folder/file name is:
$/AdvWeb/Testing/Data Conversion/LBW/SQL_LBW_Conversion.txt

Use the script syntax directly from the the Visual SourceSafe file, not the SQL text
found in this document.

The minimum LBW Conversion quality assurance steps you should perform:
• Query the LBW database to determine the number of records converted for this institution's

type of data. For example, how many MPN loans were converted for this school?
• Query the AdvanTG Web database tables that receive the converted LBW information for

the institution and get a record count.
• Reconcile the number of records reported from the LBW database, the AdvanTG Web II

database tables, and the record counts (successful and failed) reported by the LBW
Conversion.

Procedure: Evaluating the Institution's LBW Conversion using DB Queries
1. Run an SQL query against the LBW Database using one of the queries shown under the

title Access LBW Database - <Data Type>, on pages 96-101. Examine the number of
records selected by the query.

Note: <Data Type> stands for one of the LBW data categories converted—
School URLs, School Features, Preferred Lenders, MPN Applications, PLUS
Applications, MPN Certifications, or PLUS Certifications.

2. Run an SQL query against the AdvanTG Web II database using one or more of the SQL
queries under the titles Displaying <Data Type> in AdvanTG Web II Database Tables, on
pages 96-101.

3. Compare the LBW Database query, the count from AdvanTG Web II databases, and the
total number of objects (successful and failed) converted.

4. Use the AdvanTG Web Application to display specific loans for this institution and verify
that selected Social Security Numbers are stored in the AdvanTG Web II database.

5. [Optional] If incorrect LBW information was converted for this institution, run the
delete SQL operations listed under the tittles Deleting <Data Type> from the AdvanTG
Web II Database Tables, listed on pages 96-101.
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AdvanTG Web Database Tables with LBW Conversion Results
To perform quality assurance after an LBW Conversion, you need to become aware of where
the data for each LBW conversion was stored in the AdvanTG Web II Database tables:

Table 11: AdvanTG Web Database Tables Used for LBW Conversion
LBW Data AdvanTG Web Database Tables

School URLs DinstintutionURL

School Features DinstintutionFeatr

Preferred Lenders DPreferredLender

MPN Loan Applications ELoan, EInstitution, DDisbursement, EPerson

PLUS Loan Applications ELoan, EInstitution, DDisbursement, EPerson

MPN Certifications ELoan, EInstitution, DDisbursement, EPerson

PLUS Certifications ELoan, EInstitution, DDisbursement, EPerson

Deleting LBW Conversion Records added to AdvanTG Web II
If the LBW Conversion fails to convert applications, certifications, and other school
information correctly, you must run one or more of the scripts (see Appendix C – LBW
Conversion Quality Assurance) to delete the converted information.

Caution: If you ran the LBW Conversion, you must run each of scripts that
correspond to the data types you selected with the check boxes in Figure 8:  on
page 45.
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Section 6 – Export/Import Desktop Change
Transactions

This AdvanTG Web II Utility will be an extension to the Import Change Transactions software
that will also convert the additional status and timestamp information exported by AdvanTG
Desktop's modified export change transactions code.

This section covers the procedures necessary to export change transactions (CTs) from the
AdvanTG Desktop software to a text file. The text file is imported into AdvanTG Web II
database tables using the Customer Conversion Utilities (see Section 4) that follows the
standard procedure for inserting Change Transactions from the AdvanTG Import CT Use Case.

Exporting Desktop Change Transactions

Preparation of AdvanTG Desktop Database before Export CTs
Prior to importing an Institution's AdvanTG Desktop information into the AdvanTG Web II
database, several key steps happen after the customer finishes all transactions with the
AdvanTG Desktop database and before the change transactions (CTs) are exported to a text
file.

These major steps are:
1. Institution sends its AdvanTG Desktop database to TG’s Application Development and

Support (ADS) group.
2. TG’s BIT-Tech group request a portion of the institution’s Paradox database from ADS.
3. BIT-Tech creates storage on one of TG’s corporate servers for the files.
4. BIT-Tech runs a database repair utility on the database tables.
5. BIT-Tech runs a database compression utility on the database tables.
6. BIT-Tech places a copy of the repaired and compressed data files back on the corporate

server.
7. BIT-Tech upgrades the AdvanTG Desktop Software to Build 5.2 and copies the modified

Advantg.exe file (created on 10/08/02) to the executable folder. This software creates the
“modified” ChangeSend file containing extra information (see Table 12 on page 54.)

8. Run the next procedure to create the ChangeSend file that contains the exported change
transactions.

Note: If you open the exported CT file in a text editor, you will see additional
information after the normal record terminator of each ChangeSend record. This is
the information described in Table 12 on page 54.

Procedure to Create ChangeSend File from Special Desktop Software

Procedure: Export Change Transactions from the Modified AdvanTG Desktop Software
1. Start the AdvanTG Desktop application by selecting Start » Programs » Tgworks

»AdvanTG.
2. On the AdvanTG Login window type login with the Institution’s User ID and

password.
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3. Choose the Export command under the File menu. Select the Change Transaction
command from the File >>Change Transactions cascading menus.

4. Select the "Transmitted 8s, 9s, and 10s" option.
5. Press OK.
6. Under Available Export Formats, choose the CommonLine Response File –

Applications.
7. When the Save As window displays, navigate to this folder and provide a file name:

CorpFile2\\Everyone\AdvanTG Web Customer Databases\
<institution name>

Note: The filename you specify might want to reflect the institution, userID (of this
desktop), and the date-time your created this Change Send File.

Validating Exported AdvanTG Desktop CTs
Once you have created the text file (modified ChangeSend file format), you need to perform
some preliminary quality checks to ensure successful data conversion and prepare to import the
CTs into AdvanTG Web II database.

Procedure: Validating Exported Desktop CTs
1. Using AdvanTG Desktop software, display the number of Transmitted@1-8s, @1-9s, and

@1-10s records listed in the Change Maintenance window.
2. This should match the number of records exported and the number of records in the Change

Send File.
3. Record the number of records to use later as part of validating the number of Change

Transactions inserted into the AdvanTG Web databases (see Quality Assurance for Import
CTs Option on page 59.)

Desktop Exported ChangeSend File - Notes
A modified version of AdvanTG Desktop will export Change Transactions from the institution
AdvanTG Desktop Paradox database. The modified version will include status and timestamp
information along with the standard CommonLine format.

The Change Transactions imported into the AdvanTG Web II database tables are Borrower and
the Detail records:

• Schools – Change transaction types 8, 9, and 10 that are in the Transmitted status.
• Lenders – Change Transaction records with status 4 or A are exported.
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The exported CTs will then be imported into AdvWeb Phase II using a slightly modified
version of Import CT software. The modifications will import the non-CommonLine fields
exported by the modified version of AdvanTG Desktop.

The Change Transactions imported from the Change Send file (created from AdvanTG
Desktop) and inserted into AdvanTG II database tables are Borrower and Detail records in a
text format. The standard 480-character record Change Send file has an additional 86 characters
of AdvanTG Web II information which is inserted into the DCTDETAIL and ECHANGETRANS
database tables.

Table 12: Extra AdvanTG Web II Information in Change Send File
Column

Positions
Data Type and

Length
Fields AdvanTG Web Database

Table.FieldName
481-494 Date/Time

YYYYMMDDHHMMSS
Create and Update
Date/Time

ECHANGETRANS.CreateTime
DCTDETAIL.CreateTime
ECHANGETRANS.UpdateTime
DCTDETAIL.UpdateTime

495-508 Date/Time
YYYYMMDDHHMMSS

MatchTimeStamp
date/time

ECHANGETRANS.MatchTimeStamp
DCTDETAIL.MatchTimeStamp

509-522 Date/Time
YYYYMMDDHHMMSS

Submit date/time DCTDETAIL.SubmitTime

523-536 Date/Time
YYYYMMDDHHMMSS

See logic shown
below

DCTDETAIL.ChgSendRecvTime
or
DCTDETAIL.ChgRespRecvTime

537 Alpha 1 Status ECHANGETRANS.recordStatusCode
DCTDETAIL.recordStatusCode

538-549 Alpha 12 Last update user id ECHANGETRANS.LastUpdatedUserID
DCTDETAIL.LastUpdatedUserID

550-552 Alpha 3 Error code 1 DCTDETAIL.errMsgCode1

553-555 Alpha 3 Error code 2 DCTDETAIL.errMsgCode2

556-558 Alpha 3 Error code 3 DCTDETAIL.errMsgCode3

559-561 Alpha 3 Error code 4 DCTDETAIL.errMsgCode4

562-564 Alpha 3 Error code 5 DCTDETAIL.errMsgCode5

565 Alpha 1 TG change type code DCTDETAIL.TGChangeTypeCode

566 Alpha 1 Not used
• For schools, this data maps to the change response receive date and time (ChgSendRecvTime)
• For lenders, use the following logic:
If Last Update user id = ‘change send’ (not case-sensitive) then the data maps to Change Send
receive date and time (ChgSendRecvTime).

If Last Update user id = ‘common resp’ (not case-sensitive) them the data maps to Change response
receive date and time (ChgRespRecvTime).
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Table 13: AdvanTG Desktop to Web CT Codes Translation

Desktop
Code

AdvanTG Desktop
Description

AdvanTG
Web II
Code

AdvanTG Web II
Description

07-A Loan Period Change 07-D Loan Period Change

08-A Loan Cancel 08-A Loan Cancellation

08-B Loan Reinstate 08-B Loan Reinstatement

09-A + (1) Full Disbursement Cancellation 09-F Full Disbursement Cancellation

09-B + (2) Partial Disbursement
Cancellation

09-P Partial Disbursement Cancellation

09-A or
09-B (3)

Disbursement Date or
Amount Change

09-X Disbursement Date or
Amount Change

09-' ' Unknown 09-U Unknown

09-C Full Disbursement Reinstate 09-C Full Disbursement Reinstatement

09-D Add New Disbursement 09-D Add New Disbursement

09-F Partial Disbursement Cancel 09-P Partial Disbursement Cancel

09-G Full Disbursement Cancel 09-F Full Disbursement Cancel

1 Cancellation Date not blank, Cancellation Amount not 0, Revised Date blank, and Revised Amount 0.
2 Cancellation Date not blank, Cancellation Amount not 0, Revised Date not blank, & Revised Amount > 0.
3 Cancellation Date blank, Cancellation Amount 0, Revised Date not blank, & Revised Amount > 0.

Desktop
Code

AdvanTG Desktop
Description

AdvanTG
Web II
Code

AdvanTG Web II
Description

10-' ', 'A',
OR 'B'

Full or Partial
Cancel or Return

10-U Unknown

10-C Full Disbursement
Reissue/Return

10-U Unknown

10-D Partial Disbursement
Reissue/Return

10-P Partial Disbursement Cancel/Return

10-E Full Disbursement Reinstate 10-A Full Disbursement Cancel/Return

10-F Partial Disbursement Reinstate 10-R Partial Disbursement Reissue

10-G No Change 10-B Full Disbursement Reissue

11-A Refund 11-A School Refund

12-A Refund Correction 12-A School Refund Correction

13-A Sub/unsub realloc loan decrease 13-A Sub/unsub realloc loan decrease

14-A Sub/unsub realloc loan increase 14-A Sub/unsub realloc loan increase

19-A E-mail information 19-A E-mail information

24-A Loan increase 24-A Loan increase
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See these technical documents for additional details.
• Change Transaction Send File (NCHELP)

$/AdvWeb/Data Conversion/chgsnd.pdf

• AdvanTG Change Transaction File Extra Fields (Kelly Kipple)
$/AdvWeb/Data Conversion/Data Mappings for extra portion Change
Send record.doc

• Import CT Conversion Test Case(Arvind Srivastava)
$/AdvWeb/Data Conversion/Import CT Conversion TEST CASE.doc

AdvanTG Web II Import CT Conversion Database Tables - Notes
These database tables read or populated with information by the Import CT migration utility
include:

• Institution Information - EINSTITUTION
• Change Transaction Overview Information - ECHANGETRANS, DCTDETAIL
• Tables modified based on Change Transaction Type - DCTCANCEL,

DCTDISBURSEMENT, DCTEMAIL, DCTGRADELEVEL, DCTLNDREREFUND,
DCTREALLOC, DCTSCHLREFCORR, DCTSCHLREFUND

Table 14: Change Transaction Database Tables Reference
AdvanTG

Web II
Database Table

CT
Detail

Records
Change Transaction

Information in this Table
ECHANGETRANS All Borrower data records. These borrower-level transactions can

include multiple loans for the same borrower with differing
CommonLine unique identifiers.

DCTDETAIL All Details common to all Change Transactions, used to verify
which loan is referenced by the Change Transaction record.

DCTCANCEL @1-08 Loan cancellations or reinstatements.

DCTDISBURSEMENT @1-09
@1-10

Full or partial disbursement cancellations prior to the release of
funds for the disbursement.

DCTEMAIL @1-19 Borrower Email address changes

DCTGRADELEVEL @1-07 Borrower grade level changes

DCTLNDREREFUND @1-11
@1-12

Records for a school's returning of a disbursement to the
disbursing agent after the school received the money or the
reversal of such a return

DCTREALLOC @1-13
@1-14
@1-24

Reallocation of funds for subsidized and unsubsidized Stafford
loans (both pre- and post-disbursement). All 3 records must be
submitted for a loan amount increase/decrease.

DCTSCHLREFCORR @1-12 Correct a previously submitted School Refund Detail Record
post-disbursement. Both the previously reported and the
revised refund data appear in this record.

DCTSCHLREFUND @1-11 Funds being returned from a school to a disbursing agent post-
disbursement.
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For more details about the database table layouts and meaning of the specific fields, refer to:

• Database Tables Data Dictionary (Lance Smith)
$/AdvWeb/System Documentation/DB2 Database Documentation/ Database
Tables Data Dictionary.doc

• AdvanTG Web Database Table Layouts (Lance Smith)
$/AdvWeb/System Documentation/DB2 Database
Documentation/AdvanTG_Web_DB_Tables.xls

Customer Conversion Utilities – Import CTs Option

Prerequisites for running the Import CT Utility

Requirements for running the Import CTs option under the Customer Conversion
Utilities.:
• The Customer Conversion Utilities software must be deployed on the Beta or Production

environment you intend to update.
• The institution must be defined in the AdvanTG Web II database table EINISTITUTION.
• You must have exported one or more Change Send Files from AdvanTG desktop systems

used by this institution. (See Exporting Desktop Change Transactions on page 52.)
• The Application Server (WebLogic) and the B2B Server must be running. You must point

to the appropriate servers using the parameters in the import.properties file
• The AdvanTG Web database tables ECHANGETRANS and DCTDETAIL must be clean. That

is, there must not be any records (from a prior Import CT attempt) with the institution ID.
Also you must delete records from appropriate tables listed in Table 14: Change
Transaction Database Tables Reference. Which database tables require you to delete
records, depends upon the content of the institution's Change Send file you may have run
through the utility.

Caution: This involves the scenario where running the Import CT utility failed
previously. The Import CT can not validate whether duplicate records exist for this
institution. If the Import CT utility fails, you must manually delete the records from the
affected database tables. The tables you must delete records from are listed in
Table 14: Change Transaction Database Tables Reference.

Running the Import CT Option
Running the Import CT Utility is extremely easy and simple.

Procedure: Running the Import CT Option
1. Start Internet Explorer browser software.
2. Type this URL to access the Customer Conversion Utilities:

http://<dnsaddress>:7001/importdata/index.jsp
where <dnsaddress> is the appropriate AdvanTG Web environment.

3. Click the Import CTs from ChangeSend File… option on the Customer Conversion
Utilities page displays Figure 11: Import CTs from ChangeSend File - Select.

4. Click the Browse button by the Select Import CT File.
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5. Use the parent folder icon  to navigate to the working directory containing the
ChangeSend (import CT) file exported from the AdvanTG Desktop. In this example, the
file is 00363600.txt.

6. Click the filename and click the Open button.

7. Click OK on the Import CTs from ChangeSend File – Select page.
The results of importing these change transactions is shown in Figure 12.

Figure 11: Import CTs from ChangeSend File - Select

Figure 12: Import CTs from ChangeSend File - Results
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Quality Assurance for Import CTs Option
Once the CT Import operation is complete, your should validate the operations:
• Verify the Import CT data record count with the AdvanTG Web II Change Transaction

Transmission Log.
• Note any discrepancies and send an email notification to the BIT team lead (Chuck Ramos)

and Development Team/Application Support lead (Bill Roush).
• Review institution's imported change transactions for matches by randomly selecting @1-8,

@1-9, and @1-10 records in AdvanTG Web II and comparing with desktop data.

Procedure: Validating
1. Using Phase II, run the Change Transaction Transmission Log.
2. Verify that the number of records matches the number of records exported.
3. Note any record count discrepancies in previous step.
4. Send an email notification to BIT team lead (Chuck Ramos) and Development

Team/Application Support lead (Bill Roush).
5. Review institution's imported change transactions for exact matches.
6. Display the List CT window in AdvanTG Desktop software.
7. Note any discrepancy between the Change Transaction Transmission Log, exported

record counts, and the List CT window.
8. Randomly select an @1-8, a @1-9 and a @1-10 record (if available) and compare the data

in AdvanTG Web Phase II with the data in the AdvanTG desktop from which the import
was derived.

Note: Verify that each change transaction type (that is, @1-09 Pre-Disb Date
Change) is the same in both AdvanTG systems.
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Figure 13: Import CT ChangeSend File Example
@HADTG3.0             2002101411073720021014110737CHANGE TRANS       C004TTGSLC
748           GTEXAS TECH UNIVERSITY HEA       01067400      P
*                                                                                      *
@10245581094201067400       748                        GEORGE                             SUBHA
19750519
G02
*20020118110120000000000000002002011811012000000000000000TSCKSB                      C *
@09045581094201067400       748                            20010625SF   20010629819628
2001051420020511           0106740000000JAQV01
30000000020011226000000000000000000000000N00000000 N2001122600274801Y
00000000
G02
*20020118110120000000000000002002011811012000000000000000TSCKSB                      C *
@08246791204901067400       748                        CORRALES
CHRISTINA   M19810405
G03
*20021010095357000000000000002002101009535700000000000000TSCFFV                      G *
@10946791204901067400       748                            20020912SU   20020917831122
2002052920030505           010674000000B2OBB02 2200301052002101000127000 0000000000000000N
00000000
G03
*20021010095357000000000000002002101009535700000000000000TSCFFV                      G *
@10846791204901067400       748                            20020912SU   20020917831122
2002052920030505           010674000000B2OBB022002101000000000
G03                    *20021010095357000000000000002002101009535700000000000000TSCFFV
A *
@10946791204901067400       748                            20020821SU   20020826831122
2002070820030505           010674000000AW8OU02 2200301052002101000093200 0000000000000000N
00000000
G02
*20021010095357000000000000002002101009535700000000000000TSCFFV                      G *
@10846791204901067400       748                            20020821SU   20020826831122
2002070820030505           010674000000AW8OU022002101000000000
G02                    *20021010095357000000000000002002101009535700000000000000TSCFFV
A *
@T00000700000020021014110737C004TTGSLC                           748           TEXAS TECH
UNIVERSITY HEA       01067400
*
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Section 7 – Initial Load Process

Introduction

Note: When a servicer is converted to AdvWeb Phase II, the initial load program may
have to be run for each serviced institution. However, if the servicer has already set
up all loans to contain the servicer information, then the initial load program can be
run just for the servicer.

The Initial Load Process runs against the mainframe TG loans database to produce a
CommonLine (CL) Response file containing loans guaranteed by TG for a specific institution.
The user can select a how far in the past to retrieve guaranteed loans (that is 6 months, 12
months, 24 months, etc.)

The generated CL Response file is:
• Created after the mainframe programs extracts the desired institution loan guarantees
• Sent (using FTP) to a staging directory on the Production File Server.
•  [Large Institutions Only] Split into sub-files for more efficient processing by AdvanTG

Web II, if the CL Response file exceeds 20,000 records.
• Examined for quality assurance, prior to loading into the AdvanTG Web II database.
• Finally, sent to the AdvanTG Web B2B server, which processes the file contents and stores

information into AdvanTG Web II database.

Loan Extraction Overview
The Initial Load Process is requested by the Business Integration Team. They are responsible
for the control card setup, notification to Production Control via the online request forms and
monitoring of the tables. Programming staff will continue to be contacted in the case of errors
or problems in the overnight run.

The production jobs include:
• Extract for AdvanTG/AdvanTG Web Setup/Pre-Load      Job: PLPX810R

• Update for AdvanTG/AdvanTG Web  (Writes Responses) Job: PLPC820R

• Utility to convert AdvanTG to AdvanTG Web       Job: PAWX821R

• FTP the CommonLine Response file to production server Job: PAWD900R

Note: Schedule PAWD900R to run after PAWX821R for AdvanTG Web or after
PLPC820R if institution has been converted to AdvanTG Web II.
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The initial load procedure on the mainframe permits you to select guaranteed loans from its
database. Using the initial loan extraction program, you can select:

• School or Lender
• Institution ID
• Loan Period Begin Date [Extracts loans between this date and the present]
• Up to 10 different loan status indicators [Current we select all status codes]

Loan Status Codes specified for extraction:
S - Student SA - Student Assumed
X - Guar Cancelled XP - Cancelled Pending
CR - Claim Reject CP - Claim Pending
UA - Temp Unins/No Claim UB - Temp Unins/Clm Denied
UC - Perm Unins/No Claim UD - Perm Unins/Clm Denied

Setup of Loan Extraction Job
BIT-Tech requests an Initial Load Extract mainframe job to obtain guaranteed loans for this
institution and put the information in CommonLine format. Using REXX TSO panels, specify
Institutions, Loan Status, and Loan Period Begin Date (0-24 months). The Loan Status, and
Loan Period Begin Date are taken from the CONS Consultant Checklist. Specify request for
AdvanTG Web Setup and Database Load. On the request form, check: Next Business Day and
Extract, Update, Utility, and PAWD900R (FTP file transfer) jobs.

Note: Submit this request to Production Control at the Close of Business on Day 1.
This mainframe job must be run after all batch processes complete, about 6 a.m. on
Day 2.

The following REXX panels (see Figure x  through Figure y) create control cards for use by
PLPX810R (extract) which is used for the AdvanTG setup or initial pre-load request. After the
data is entered via the REXX panels, BIT-Tech complete the Request form located at:
CorpFile2\Everyone\Prod_Cntrl Requests\PSG Request Forms
\AdvanTG_InitialLoad
and submits to Production Control so they can copy the updated control cards to production.

Figure 14: Main Request Screen
In ISPF, L9 utility:
1) A   -  Application - Application Utilities
2) AL -  AdvanTG Load
3) A1 - Option 3 Copy to TGPROD.CNTLCARD.LIB(LPC00810)
4) A1 - Option 4 View TGPROD.CNTLCARD.LIB(LPC00810)

Procedure: Submitting Request for Loan Extraction Process
1. Logon TSO and the Main Request Screen will display.
2. Select L9 - TG Utilities
3. Select A - Application Utilities on main request screen.
4. Select AL - AdvanTG Load to display Figure 15: Create PLPX810R Control Cards.
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Figure 15: Create PLPX810R Control Cards

5. Option 1 is selected to enter the control card data.  When you press [Enter] you will get a
TSO message that you should just ignore:
Note: The 'PLPX810W' file may already be open. In this case, please
disregard any 'IKJ56861I PLPX810W UNALLOCATED' message…

Caution: Options 3 and 4 in Figure 15 are run by TG's Production Control group to
move the generated JCL to a production library.

Figure 16: Specify Loan Extraction Parameters



Customer Conversion User Guide v2.2 Section 7 – Initial Load Process

Adding Revisions - 12/17/2002 64 TG Confidential and Proprietary Information

6. Press [Enter] again to display

7. 
Caution: Options 3 and 4 in Figure 15 are run by TG's Production Control group to
move the generated JCL to a production library.

8. Figure 16: Specify Loan Extraction Parameters.

9. Type the appropriate data based on the fields.

10. You can enter lenders, schools or servicers. A servicer can be entered as an 'L' Institution
Type.

11. The Loan Period Begin Date extracts all loans with the statuses indicated that have a start
date equal to or later than the date you enter here.

Note: This is not a date range.

Note: Statuses allow us to customize the initial load for the institution. The most
common request is for S and SA (all active loans)

Note: If they also request loans that have been cancelled, then you need to type X
and XP.

12. When the entry is complete press [Enter] to accept this transaction or process additional
transactions. Press [PF3] to exit and return to selection screen.

13. Use Option 2 to view, change, or delete (if necessary) the control card(s) developed.

14. When you press [Enter] you get a TSO message. Press [Enter] again.

15. Figure 17:  display the items entered via Option 1. This screen updates fields previously
entered or deletes  the entire line. If a change is needed the field can be accessed by tabbing
to the desired field. The change is typed over the existing data.

16. Press [Enter] and the change is accepted.

Figure 17: View, Modify, or Delete PLPX810R Control Cards
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17. To delete, tab to the 'D to Delete' column and press [Enter].

18. Once the line has been deleted and all updates are complete press [PF3] to exit.

Production Control updates the actual PROD control card to be used in the JCL and copies the
control card from the working file to the actual PROD file.

Troubleshooting the Loan Extraction Setup
When a user attempts to use the AdvanTG Initial Load process and receives this error message,
most likely another user is accessing the process at the same time. Please follow the
instructions below to determine which user is accessing the process.

Error message displayed on screen:
ISPT033 - Table already open
TBOPEN issued for table PLPC820R that is already open.
or
TBOPEN issued for table PLPX810W that is already open.

Current dialog statement
TBOPEN PLPC820R WRITE LIBRARY(PLPC820R)
or
TBOPEN PLPX810W WRITE LIBRARY(PLPX810W)
Enter HELP command for further information regarding this error.
Press ENTER key to terminate the dialog.

The following members should be researched to determine which user is accessing the
process.
=3.4 for TGTEST.ISPF.APALU10A.TABLES - member PLPC820R
=3.4 for TGTEST.ISPF.APALA10W.TABLES - member PLPX810W

Caution: Users should completely exit TSO to clear the AdvanTG Initial Load
process for the next user.

Running the Loan Extraction Mainframe Jobs

On the TG Mainframe a series of production jobs run to perform these operations:
• Extract all the guaranteed loans that meet the initial loan extraction criteria specified on

page 62. When this program runs, the data
• Format the CommonLine (CL) Response file with its headers, trailers, plus all @1 and @2

records into appropriate CL4 format.
• Remove unnecessary TG mailbox IDs from the Initial Load file.
• FTP the Initial Load file to the desired production server folder.

Moving to AdvanTG Web II
The CommonLine (CL) Response File generated on the mainframe is sent to a "working"
directory on the AdvanTG Web production server. Next you should follow this procedure to
process the CL Response file.
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Procedure: Processing the CL response File from Initial Load Procedure
1. Examine the CL response file and determine if the file needs to be split into individual

institutions.
2. Determine the number of records to insert into AdvanTG Web II database tables: Parsed

Records = (File Records – 2)/2

3. If the number of records exceeds 20,000, use the Split Initial Load File… option
to split the file into sub-files, containing a smaller number of records. [About 20,000
records per sub-file].

4. Move the original CL Response File or the created sub-files to the SockeyeQ folder on the
file server (advsmorey, advftp, etc.).

5. Once the response file is processed, select the number of records for this institution in the
AdvanTG Web II database table EPARSEINFORMATION.

6. Use the AdvanTG Web II application to verify that specific guaranteed loans
(LoanStatusCode = 'G') exist in the database.

7. The number of loans in the AdvanTG Web II database should equal about one-half the
number of the records in the original CL Response file.

[Optional] Split CL Response File
The Split Initial Load File… option in the Customer Conversion Utilities takes a CL response
file (created by the Loan Extraction process) that is too large for efficient processing and
divides it into smaller sub-files, that can be successfully processed using the AdvanTG Web II
B2B Server. Once the sub-files are created, they are copied to a "destination folder", where TG
personnel can examine and validate this information, prior to loading into the AdvanTG Web II
database.

Requirements for Running the Split Initial Load File… Option

Prior to running the Split Initial Load File… Option, you must:
• Receive the CL Response file sent from the mainframe and place it in a "working"

directory folder.
• No other person is running the Customer Conversion Utilities.

Split Initial Load File… Option

Procedure: Running the Split Initial Load File into Multiple CL Response Files
1. Start Internet Explorer browser software.
2. Type this URL to access the Customer Conversion Utilities:

http://<dnsaddress>:7001/importdata/index.jsp
where <dnsaddress> is the appropriate AdvanTG Web environment.

3. Click the Split Initial Load File into Multiple CL Response Files option on the
Customer Conversion Utilities page to display Figure 18: Split Initial Load File into
Multiple CL Response Files - Select.

4. Select the number of Loans Per File to place in a sub-file. The number of records should
be set to 20,000. This value has worked well in initial testing and should be adequate for
AdvanTG Web II production.

5. Click the Browse button for the Source File/Folder.
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6. Use the parent folder icon  to navigate to the working directory containing the CL
Response file sent from the TG mainframe Loan Extraction production job. In this
example, the file is CMLN.RSPFTP.2002110509260010.

7. Click the filename and click the Open button.

8. Click OK on the Split Initial Load File into Multiple CL Response Files - Select page.
The results of splitting this CL Response file is shown in Figure 19.

9. Place the sub-files in the AdvanTG Web II BPLM folder.

Figure 18: Split Initial Load File into Multiple CL Response Files - Select

Note: The number of records should be set to 20,000. This value has worked well
in initial testing and should be adequate for AdvanTG Web II production.

Sub-file Contents after Split Initial Load File… Option Runs

The original CL response file is broken up into sub-files. Each sub-file consists of a
header record, a selected number of data records, and a trailer record.
• Header - The header record is the same as the header record for the original response file

and is consequently identical for all sub-files.
• Data Records - The number of data records per sub-file is between filesize and filesize + 6

records. A sub-file may contain more than the number of records specified in the filesize
parameter because an application may have more than one data record in the file. All the
data records associated with a particular application are adjacent in the file with the '@1'
record coming first. Since the data records for an application cannot be split across two
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sub-files, a sub-file may contain more data records than what is specified by the filesize
parameter. The additional data records are associated with last '@1' record in the sub-file.

• Trailer - The record count fields in the trailer record (that is, @1 detail count, @2 detail
count, etc.) reflect the record counts in the sub-file. The remaining trailer record fields are
obtained from the corresponding field in the Header record. Apart from the record counts,
the trailer records in the sub-files should be identical to each other and to the trailer record
in the original CL response file.

Figure 19: Split Initial Load File into Multiple CL Response Files - Results

Troubleshooting
Once the CL Response file (or its sub-files) are placed in the AdvanTG Web II BPLM folder
and processed as CommonLine Response files, you should validate the results of inserting the
guaranteed loans into the database.
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Procedure: Validate Guaranteed Loans inserted into AdvanTG Web II
1. Examine the CL Response File and sub-files for their record counts.
2. Place the file(s) in the AdvanTG Web II BPLM folder.
3. Ensure number of loans inserted into AdvanTG Web tables equals the CL Response file

record counts.
4. Send number of loans/record counts in email to BIT lead (Chuck Ramos).
5. Review institution's initial load (guaranteed loans)in AdvanTG Web II by verifying the

record count on the Receive Results Report.
6. Navigate to the Receive Results Report page using the Internet pages:

Menu » Reporting » Transmission Reports » Receive Results Report
7. Keep the Date Range the same as the current date.
8. Click OK.
9. Examine to the Total number of records listed at the bottom of the report.

Note: The number of loan records in AWII is nearly the same as the number of
records extracted (there may be a few discrepancies due to garbage data on the
mainframe).

CL Response File Format

Figure 20: Example CL Response File
@H[Header]ADTG2.0             2002082916015020020829160150COMMON RESPONSE    R004PTX A&M-
KINGSVILLE               00363900      STEXAS GUAR STUDENT LOAN CORP    748           M

*
@1M[Response Record]20020829EREBIA                             GLENDA      M455514233PO BOX 5383
KINGSVILLE                    TX783630000361592278919800712SF999999
NYN000000000036390000MHFU9KL01  TX000000  Y
00000000000000000                       00363900  20020826200305083
F2004051300000000000000001000000000000020020813                00000000000
81079801000000000000020020822A00000              748M                    N
2002082200500000001500000000000485002003010600500000001500000000000485000000000000000000000000000
000000000000000000000000000000000000000000000002002082201000SU                    TXTX18656127
45551423320031         RR  P                                                            AA  N
010010000000000000AELN20020822G01                    00000000   0000000
000000000000000000000000000003460    N000000000000000      S                  *
@2ADTG02006000000000000030000000000346034603460010000000009650000965000096531NBC BANK, N.A.
9566826371% COSTEP                 P.O. BOX 6500            MCALLEN        TX785026500TEXAS A&M
UNIVERSITY-KING3615933982FINANCIAL AID OFFICE     700 UNIVERSITY MSC 115   KINGSVILLE
TX783630000 GQGQGQSASASA03000300810798000
*
@1M20020829EZELL                              DEBRA       E45929611223218 CANYON LAKE
SPRING
TX770760000281355583819590904PL999999NYNN000000000036390000MHLE9NT01 1TX000000N N
EZELL                              JESSICA     L644016606198308011N                     00363900
20020826200305081 F2006121211094195560762500000000000500020020815                00000000000
82004300000000000500020020822A00000              748P                    N
2002082202500000007500000000002425002003010602500000007500000000002425000000000000000000000000000
000000000000000000000000000000000000000000000002002082205000 U                    TX02979151
64401660620032         RR  P                                                            AA  N
010000000000500000AELN20020822P01                    00000000   0000000
000000000000000000000000000004860    N000000000000000      S                               *
@2ADTG0200000000000000003000000000048604860486005000000005062000506200050622 WASHINGTON MUTUAL
8882725543C/O LSC/TX               P. O. BOX 12229          KILLEEN        TX765470000TEXAS A&M
UNIVERSITY-KING3615933982FINANCIAL AID OFFICE     700 UNIVERSITY MSC 115   KINGSVILLE
TX783630000 PTPTPTSASASA03000300820043000
*
@T[Trailer]00042700042700000020020829160151R004PTX A&M-KINGSVILLE               00363900
TEXAS GUAR STUDENT LOAN CORP    748           000000000000000000000000

*

The CL Response File produced by the mainframe or the sub-files created by the Split CL
Response File option, consist of @1M, modification response records.
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This format is documented in the NCHELP CommonLine Network for FFELP and Alternative
Loans Response File – Change Transaction Send File manual.
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Section 8 – Mark Exported Data

Overview
This AdvanTG Web II utility marks all loans and change transactions for a given institution as
"exported". This will be run after the Initial Loan Load (see Section 7 – Initial Load Process)
so that institutions don't end up getting thousands of loans exported the first time they run
Export Loans in AdvWeb II. The receive date for those loans will also be set back in time by 24
hours.

Note: Large Servicers will be converted on weekends, since dependent institutions
must also be converted.

Mark Exported Data Option
This option updates loans and change transactions database records from the three major
AdvanTG Web Customer Conversion procedures:

• Section 5 – LBW Conversion Procedures
• Section 6 – Export/Import Desktop Change Transactions
• Section 7 – Initial Load Process

Procedure: Run the Mark Export Data Utility
1. Start Internet Explorer browser software.

2. Type this URL to access the Customer Conversion Utilities:
http://<dnsaddress>:7001/importdata/index.jsp
where <dnsaddress> is the appropriate AdvanTG Web environment.

3. Click the Mark Exported Data in AdvanTG Web DB option on the Customer
Conversion Utilities page to displays Figure 21: Mark Exported Data in AdvanTG Web
DB - Select.

4. Select the institution type by clicking the School or Lender option buttons.

5. Type the needed DOE ID (Department of Education ID) for the institution (school or
lender), Servicer DOEID for lenders, and the optional Non-DOE Branch IDs if
necessary.

6. Choose Staging/UAT, Beta, Production, or Production-Staging from the Select
Database drop-down list

7. Click OK.

8. Figure 22:  on page 73 displays to show the record counts of the AdvanTG Web database
tables (ELoan, EChangeTrans, DCTDetail) modified.
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Figure 21: Mark Exported Data in AdvanTG Web DB - Select

Validate Mark Exported Data Option
Verify that the record counts approximate the number of loans/certifications and change
transactions provided by the three major customer conversion procedures (Initial Load, LBW
Conversion, and Import CTs.)

If the number of records does not match the number of loans converted from LBW, AdvanTG
Desktop CTs, and the institution's initial load, you can immediate "rollback" or undo the
AdvanTG Web database updates. See Troubleshooting on page 73.

Procedure: Validate the Mark Exported Data
1. Login to AdvanTG Web.
2. Go to Export Responses page.
3. Verify the number of CL4 records available to export is zero.
4. Attempt to do an export using the date range (use today's date in the To and From fields).

The result should be No records exported.

5. Go to the Loan Response report. Run the report with the Refresh option selected
       and the current date as the To and From dates. No records should be returned.
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Figure 22: Mark Exported Data in AdvanTG Web DB - Results

Troubleshooting
When the record counts shown in Figure 22 do not match the expected number of loans and
change transactions or another quality assurance problem has surfaced, you can undo the
database updates with another utility.

Procedure: Undo Mark Exported Data Updates
1. Start Internet Explorer browser.

2. Type this URL to access the Customer Conversion Utilities
http://<dnsaddress>:7001/importdata/index.jsp
where <dnsaddress> is the appropriate AdvanTG Web environment.

3. Click the Undo the Previous Mark Exported Data Operation on Figure 1. Figure 23:
Undo Last Mark Exported Data Operation - Select displays to show you the results of the
previous Mark Exported Data Operation.

4. Verify that this is the Institution DOE ID and the correct Database you need to undo the
exported data marking.

5. Click OK. A screen similar to Figure 24: Undo Last Mark Exported Data Operation -
Results on page 74 displays.
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Caution: You can only Undo the previous Mark Exported Data operation. Each
institution's operation is not saved; only the previous operation.

Figure 23: Undo Last Mark Exported Data Operation - Select

Figure 24: Undo Last Mark Exported Data Operation - Results
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Database Information Changed
When the user runs the Mark Exported Data in AdvanTG Web DB procedure or undoes the
operation, AdvanTG Web database tables are updated. Table 15: Mark Exported Loans –
Database Changes describes the AdvanTG Web II database tables and database fields updated
based upon the institution type—school or  lender.

Note: Only school or lender loans with the LoanAppCode=L are modified in the
ELoan database table.

(1) If the Date/Time field is null or blank, the date/time field is set to a value of:
          Updated DATETIME Field = Current Date – 24 Hours

Table 15: Mark Exported Loans – Database Changes

Sc
ho

ol
s

Le
nd

er
s

AdvanTG Web II
Database Table

Name
Database Table

Field Name
Modification
to Data Field

X X ELOAN EXPORTSTATUS Set to 'Y"

X X ELOAN LOANAPPCODE None – This field must be an "L"
X X ELOAN CREATETIME Set CREATETIME – 24 Hours1

X X ELOAN UPDATETIME Set UPDATETIME – 24 Hours1

X X ELOAN LOANREFRRECVTIME Set LOANREFRRECVTIME – 24 Hours1

X ECHANGETRANS CREATETIME Set CREATETIME – 24 Hours1

X X ECHANGETRANS UPDATETIME Set UPDATETIME – 24 Hours1

X DCTDETAIL EXPORTSTATUS Change to "Y"

X DCTDETAIL CREATETIME Set CREATETIME – 24 Hours1

X X DCTDETAIL UPDATETIME Set UPDATETIME – 24 Hours1

X DCTDETAIL CHGSENDRECVTIME Set to CHGSENDRECVTIME - 24 Hours1
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Section 9 – Security Setup Procedures
Note: Security Administration instructions and procedures are located in the folder -
Corpfile2\ IRM-Security Administration\SA-INST\External
Customers\Instructions for External Customer Requests.doc. For
additional information about Security Administration’s instructions, contact Lucille
Santillo (Information Security Analyst) at (800) 252-9753, extension 4904.

Introduction
This section summarizes the steps necessary in the customer conversion process to setup user
security and roles for the new AdvanTG Web users.

Most security procedures need to be completed one to two weeks prior to converting a TG
institution to AdvanTG Web Phase II.

Security setup information must be gathered and sent to an Information Security Analyst
(Technology Services – Admin group) five business days prior to institution implementation.

Key security actions are summarized in Table 16, Security Setup Summary.

Table 16: Security Setup Summary

Assigned
Team

Existing
Phase I

User

Deadline
Prior To

Conversion Customer Conversion Action
CONS N/A 2 Weeks Each user fills out and signs TG Web Products security form

CONS N/A 2 Weeks Document User Roles and Capabilities with AdvanTG Web II
Technical Checklist

BIT N/A 2 Weeks Identify User Roles and Capabilities
Forward to TS - Administration

SEC No 1 Week New User Requests

TS Yes 1 Week Convert Phase I users to LDAP AdvanTG Web II

SEC N/A 4 Days Return User IDs to BIT

BIT N/A 4 Days Define user roles using the AdvanTG Web GUI

CONS N/A 4 Days Perform quality assurance, verify user profiles

Steps for All Users

Fill-out TG Web Products Security Form for each User
Customer Service Consultants (CONS) interview staff for information about
— User names, user roles, and related information for TG security forms
      (See Table 17: User Roles for Schools and Lenders on page 78.)
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Identify User Roles with AdvanTG Web Phase II Technical Checklist

BIT (Business Integration Team) performs several actions for user security:
• Verifies security information for new users
• Identifies user roles for lenders and schools
• Determine each user's access to Applications, Loans, and Reports.
• Forwards the new user ID requests to Technical Services – Administration.

Caution: Security (TS - Administration) needs customer User Requests one week prior to
implementation day.

Define User IDs – Data Entry or Phase I Users Conversion
[New Users] Security (TS – Administration) establishes the user accounts, passwords, and
relates them to this new TG institution using their internal procedures.

[Existing Phase I users] Security will export a file (single institution) containing this
information:

• User Name
• Department
• Division
• Institution ID
• Access to RTA (Real Time Access) mainframe ID and password

[Existing Phase I users] The AdvanTG development team (TS – Administration) will use
scripts to directly load Phase I security information into the AdvanTG Phase II LDAP security
servers.
(See LDAP  and iPlanet Directory Server in the Terminology section on page 11.)

[All Users] Security returns user IDs and passwords for the institution to BIT.

Define User Rights in AdvanTG Web II
When Customer Service -BIT) set-up users to use AdvanTG Web II, they give them certain
rights within AdvanTG Web II. These rights determine what areas of the application the user
can access and what the user can do in those areas in terms of viewing, editing, or deleting data
belonging to the user. Table 17 briefly describes the various levels of user rights.

Caution: Institutions should notify TG when changes occur in personnel assigned
AdvanTG Web II responsibilities. TG will make any necessary changes to user
profiles; adding or changing user rights.
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Table 17: User Roles for Schools and Lenders
Designation TG School Lender Meaning

Institution
Administrator

X

View Only X X X • View records
• Run Reports
• List Institutions

Add X X • Create Records

Add/Modify X X • Create and Edit Records
• Import and Export

Add/Modify/ Delete X X X • Create, edit, and delete records.
• Import and Export

Superuser X X X All authority of the Add/Modify/Delete user.
Superusers can view and edit abilities for most
areas of AdvanTG Web, including the ability to
set certain aspects of an institution's profile such
as global default values and records purge
criteria (see Table 3).

Verify User Security Setup in AdvanTG Web Phase II
BIT distributes the user IDs and passwords to the Customer Services - Consultants to hold for
the customer until implementation day.
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Section 10 – Renaming AdvanTG Phase I Files

Overview
Since ConnecTG was disabled for the Institution, all responses (including those from the
Submits done before the shutdown of AdvanTG Desktop) will queue-up on the Moray server.
At this point, those responses must be decrypted, copied to the AdvWeb Phase II BPLM
folders, and processed as Response Files using the standard receive CommonLine response
process. These responses could include normal responses, error responses, RRD data, etc.

File Renaming Standards

Table 18: AdvanTG File Naming Conventions
AdvanTG

Web
Phase File Description File Naming Convention Search Template

II Application Send, Change
Transactions, Response,
Disbursement Roster

CMLN.<File Type>
<UniqueID>.<Inst ID>

CMLN.*.<Inst ID>

I CommonLine
AdvWeb Desktop

1002.<Inst ID>.* 1002.<Inst ID>.*

II AGD, CIR, ESR, DMR,
Application Reject

RRD.<File Type>
<UniqueID>.<Inst ID>

RRD.*.<Inst ID>

I Report Request
Distribution Files

1003.<Inst ID>.* 1003.<Inst ID>.*

II Multiple Applications for
Instant Guarantee

IGL.<Inst ID>.<UniqueID>.TXT IGL.<Inst ID>.*

I IG Lender 1001.<Inst ID>.* 1001.<Inst ID>.*

II TG Warehouse sent
CommonLine Files

TGW.<File Type>
<UniqueID>.<Inst ID>

TGW.*.<Inst ID>

II Nightly Institution
Synchronization

INST.<UniqueID> INST.*

Renaming Procedure
As part of the customer conversion process, the BIT-Tech will search all files belonging to a
specific institution identifier, referred to in this section as <Inst ID>. These are the most
recent customer CommonLine Response files received during Day 2 of Implementation week.

The BIT-Tech team will perform the conversion from Phase 1 to Phase 2 by:
1. Copying the CL Response files from the institution's ConnecTG mailbox on the production

system (Moray server) to a corporate server folder.
2. Using a decryption utility to convert the file into plain text that the AdvanTG Web system

can process.
3. Changing the file name from  AdvanTG Phase 1 name to the AdvanTG Web II naming

standard. (See Table 18: AdvanTG File Naming Conventions on page 79.)
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4. Copying the file to the Business Logic Process Module (BPLM) on the production server
so it can be processed as an AdvanTG Web II CLMN Response file.
\\Moray\BE_BPLM

Note: To locate the proper Phase 1 mailbox identifier, you must take the institution's
DOE ID and convert the decimal number to hexidecimal.

Example: Texas A&M's DOE ID is 00363200 and its phase 1 mailbox ID is 058AC0.

Procedure: Copy Files from the Moray Phase 1 Mailbox
1. On Moray server, navigate to the ConnecTG mailbox folder that corresponds to institution's

hexadecimal DOE ID. (Figure 25: Moray Server – Phase 1 ).
2. Identify the appropriate folder using the <MailBox ID> for this specific institution found

in Appendix A – Institution Information on page 83.

Procedure: Decrypt Phase 1 Files to Plain Text
1. Change any RRD files from 1003* to 1002* to get the decryption utility to work.
2. Using the AdvanTG Desktop Decrypt Utility, convert the Phase 1 file's internally encrypted

contents to plain text.
3. Copy desired files from this folder and place in the corporate file folder: Corpfile2\

\AdvanTG Web Conversions\<Institution Name>\<MailBox ID>

Caution: RRD files (designated 1003*) must be temporariily renamed 1002* for the
Decrypt Utility to function properly.

Procedure: Change File Names from Phase 1 Names to Phase 2 Names
1. Rename the files to conform to the naming conventions in Table 18: AdvanTG File Naming

Conventions on page 79.
2. For all files (except RRD—1003*), change the first node of the file name from 1002 to

CMLN and keep the remaining portion of the file name as is.
Example:  1002.xxxxxxx becomes CMLN.xxxxxxx

3. All the RRD files will have the first node changed to RRD.

Note: As you rename files, you can open these small files with a text editor to
determine the exact file type. RRD files are not in CommonLine format.

Procedure: Move renamed files to Production Folders
4. Once you have renamed the files, copy the files to the same BPLM as the "normal and real"

production server folder.  \\Moray\BE_BPLM_Storage (See Figure 26.
5. The BPLM program moves the CMLN files to the proper server.
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Figure 25: Moray Server – Phase 1 Mailbox and Corporate Server

            

Restoration Procedure
When AdvanTG Web II is in full production, the Product Support Group (PSG) will use this
same procedure to "proactively" repair specific files.

Note: Folder locations for files to be renamed or repaired for AdvanTG Web II:

TG Customer Conversion: TBD
Production: \\Advftp\ConnecTG Server\Archive\AdvWeb
Production: \\Advftp\ConnecTG Server\ProblemFiles\AdvWeb

Beta: \\advsmoray\ConnecTG Server\Archive\AdvWeb

Staging: \\advsftp\ConnecTG Server\Archive\AdvWeb

Using the AdvanTG file naming standards shown in File Renaming Standards on page 79 and
the following procedure, you can convert/repair files within the AdvanTG Web Phase II
framework.
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Procedure: Restoring AdvanTG Web II Files
1. Login to the appropriate server (Beta, Staging, or Production) using Terminal Services

Client with your user ID and password.
2. Start Internet Explorer to search for the files specific to the institution's ID.
3. Using Internet Explorer, navigate to the folder location provided in the above note.
4. Using the file name templates in Table 18 on page 79, search for all the institution's files.
5. Copy the files to your local PC.
6. [AdvanTG Web I or Desktop file name] Rename the file to the appropriate AdvanTG

Web Phase II file name.
7. [Unprocessed AdvanTG Web II file] Modify any records in the file as needed..
8. Use Internet Explorer to navigate to the folder to process files.

(See Figure 26: AdvanTG Web File Folder Structure on page 82.)
9. Copy the file from your local disk to the Business Process Logic Module – Backend

BE_BPLM_Storage folder.
10. The file should disappear within seconds of being copied to the BE_BPLM_Storage folder.

Figure 26: AdvanTG Web File Folder Structure

AdvanTG Web II files that
may require reposting
Copy files for
processing
2 TG Confidential and Proprietary Information

Problem AdvanTG
Web II Files

Subfolders are
Institution mailboxes



Customer Conversion User Guide v2.2 Appendix A – Institution Information and Go-Live Dates (12/16/02)

Adding Revisions - 12/17/2002 83 TG Confidential and Proprietary Information

Appendix A – Institution Information and Go-Live Dates (12/16/02)
Business Integration Team (BIT-Tech) and AdvanTG Web Development (DEV) staff performing customer conversion steps shown in Appendix B:
• PP – Praveen Pathi

AS – Arvind Srivastava
• KG – Karen Greening

WH – Wendy Hoch
SE – Suzy Epley

Table 19: Institution and Go-Live Information (12/06/02)

Tier School or Lender Name
School ID
Lender ID

Phase 1
Mailbox ID Data Types

Go-
Live
Date

BIT-
Tech

Person

DEV
Person

LB
W

AW
Ph

as
e

1
R

TA

Im
po

rt
C

T

In
iti

al
Lo

ad

D
O

N
E

2 TTHSC 01067400 104988 MPN Certs 12/04 KG PP X X X Yes Yes YES

1 Texas Tech 00364400 058F70 ???? 12/04 WH AS Yes Yes YES

1 Wayland Baptist University 00366300 0596DC Sub, Unsub 12/05 SE AS X X X Yes Yes YES

1 Texas A&M – Kingsville 00363900 058D7C ???? 12/05 WH PP X X Yes Yes YES

1 Texas Wesleyan School of Law 00364501 058FD5 Sub, Unsub 12/06 SE AS X X Yes Yes YES

1 Texas Wesleyan University (10) 00364500 058FD4 MPN Certs/Apps
PLUS Certs, URL
Preferred Lenders

12/06 SE AS X X X Yes Yes YES

1 University of Texas at Austin 00365800 0594E8 PLUS Certs/Apps
School URL, LWC

12/06 KG PP X X X Yes Yes YES

1 Texas A&M University 00363200 058AC0 Sub, Unsub, LWC 12/09 KG AS X X X Yes Yes

2 Texas A&M University-Galveston 00363204 058AC4 Sub, Unsub 12/09 WH PP X X Yes Yes

1 University of North Texas 00359400 057BE8 PLUS , LWC 12/10 WH AS X X Yes Yes

1 Rice University 00360400 057FD0 Sub, Unsub, PLUS 12/10 KG PP X X Yes Yes
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Tier School or Lender Name
School ID
Lender ID

Phase 1
Mailbox ID Data Types

Go-
Live
Date

BIT-
Tech

Person

DEV
Person

LB
W

AW
Ph

as
e

1
R

TA

Im
po

rt
C

T

In
iti

al
Lo

ad

D
O

N
E

1 Iverson Business School and
Court Reporting

02580100 0275E84 ???? ??? SE AS Yes Yes

1 Business Skills Insti.-Las Cruces
Business Skills Institute-El Paso

02532900
02532901

026A624
026A625

???? ??? SE AS Yes Yes

1 Florida National College 02547600
02547601

26DF90
26DF91

???? ??? SE PP Yes Yes

1 Ittawamba Business College 00240900 03AD04 ???? 12/12 WH AS X Yes Yes

1 Texas Christian University (8) 00363600 058C50 Sub, Unsub, PLUS 12/13 KG PP X Yes Yes

2 Shorter College 01/15 ?? ?? Yes Yes

1 Intl Business College – El Paso
Intl Business College – Lubbock

00908200
02538900

0DDBA8
26BD94

???? 01/16 SE AS
X X

Yes Yes

2 Baylor University 00354500 0568C4 Sub, Unsub, LWC 01/22 ?? ?? X Yes Yes

2 Wharton County Community 00366800 0598D0 Sub, Unsub 01/22 ?? ?? X X Yes Yes

2 Southern Methodist University 00361300 058354 Sub, Unsub, PLUS
LWC - Perf

01/23 ?? ?? X Yes Yes

2 University of Houston-Victoria 01323100 14305C Sub, Unsub 01/23 ?? ?? X Yes Yes

2 Sam Houston State University 00360600 058098 Sub, Unsub, PLUS 01/24 ?? ?? X Yes Yes

2 UT at Tyler 01116300 11088C Sub, Unsub, PLUS 01/24 ?? ?? X Yes Yes

2 Richland College 00850400 0CF9E0 Sub, Unsub, PLUS 01/28 ?? ?? X Yes Yes

2 Southwestern Assemblies of God 00361600 058480 Sub, Unsub 01/28 ?? ?? X Yes Yes

2 UT at Dallas 00974100 0EDD14 Sub, Unsub 01/29 ?? ?? X Yes Yes

2 Dallas Baptist University 00356000 056EA0 Sub, Unsub 01/30 ?? ?? X Yes Yes

2 UT at Arlington 00365600 059420 Sub, Unsub, LWC 01/30 ?? ?? X Yes Yes
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Tier School or Lender Name
School ID
Lender ID

Phase 1
Mailbox ID Data Types

Go-
Live
Date

BIT-
Tech

Person

DEV
Person

LB
W

AW
Ph

as
e

1
R

TA

Im
po

rt
C

T

In
iti

al
Lo

ad

D
O

N
E

2 McMurry University 00359100 057ABC Sub, Unsub 02/12 ?? ?? X Yes Yes

2 Hardin-Simmons University 00357100 0572EC Sub, Unsub, PLUS 02/13 ?? ?? X Yes Yes

2 Midwestern State University (7) 00359200 057B20 Sub, Unsub, PLUS 02/13 ?? ?? X Yes Yes

2 Howard Payne University 00357500 05747C Sub, Unsub 02/14 ?? ?? X Yes Yes

2 West Texas A & M University 00366500 0597A4 Sub, Unsub, PLUS 02/19 ?? ?? X Yes Yes

2 Stephen F. Austin University 00362400 0587A0 Sub, Unsub, PLUS 02/19 ?? ?? X Yes Yes

2 Vernon College 01006000 OF59B0 Sub 02/21 ?? ?? X Yes Yes

Austin Community College 01201500 12555C

Houston Community 01063300

Huston-Tillotson 00357700

Praire View 0036300

South Texas Law 00497700

Southwest Christian 00361800 058548

Southwest Texas State 00361500

Southwestern University 00362000 058610

Texas A&M – Corpus Christi 01116100

Texas Southern 00364200

University of Texas at El Paso 00366100 059614 LWC - Perf

UT - Permian Basin 00993000 0F26E8 Sub, Unsub X Yes Yes

Aggieland Credit Union 830445 X X Yes Yes

Bank of America 832733 Yes Yes

Commercial Bank X X Yes Yes

PPHEA Yes Yes
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Tier School or Lender Name
School ID
Lender ID

Phase 1
Mailbox ID Data Types

Go-
Live
Date

BIT-
Tech

Person

DEV
Person

LB
W

AW
Ph

as
e

1
R

TA

Im
po

rt
C

T

In
iti

al
Lo

ad

D
O

N
E

1st National Abilene 810778 0C5F1A X

PNB Financial 833314 0CB722

University Federal 828148 0CA2F4

Texas Culinary (1) Yes Yes

Austin Business College (1) Yes Yes

Arkansas State Univ. 00109000 01A9C8 X

California Inst Integral Stud 01215400 128BA8 X

Colorado Christian Univ. 00940100 0E5844 X

Colorado Technical Univ. 01014800 0F7C10 X

Denver Seminary 00135200 021020 X

Faulkner Univ. 00100300 0187CC X

Southern Adventist Univ. 00351800 055E38 X

Univ. of Detroit Mercy 00232300 038B6C X

Western Career College 00974800 0EDFD0 X

Wilberforce Univ. 00314100 04CAF4 X
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Appendix B – Customer Conversion Checklist (12/17/02)
Table 20: [Page 1 of 8] Customer Conversion – 12/17/02 Activity Checklist for Institution _________________________________________
Development Contact _____________________________ Consultant Contact _______________________________________________

Done
Implementation

Scheduled Group Customers Action Completed

1. 
One-two weeks before CONS All Determine institution's Internet hardware, software, and infrastructure meets AdvanTG Web II

requirements.

2. 
One-two weeks before CONS All Gather all security information (User IDs, names, roles, rights)

3. 
One-two weeks before CONS All Determine Institution's profile, LBW features, and optional URLs.

Fax this information to BIT.

4. 
One-two weeks before CONS All Determine the Loan Start Date and Loan Statuses to be used for this institution when the

Initial Load–Loan Extract process is run on Day 2.
Email this information to the address: BITREQUEST@TGSLC.ORG

5. 
One-two weeks before BIT All Identify user roles for Schools and Lenders per Consultant Checklist

6. 
One-two weeks before BIT-

Tech
All If institution has POP3 trading partners, contact institution's trading partners to confirm POP3

email address change and request any public security keys that need to be added to TG
Warehouse per Consultant Checklist. (Needed only for an institution’s Alternative Loan process.)

7. 
One-two weeks before CONS Desktop Determine size and method to transfer AdvanTG Desktop databases to BIT-Tech team members

8. 
One-two weeks before CONS All Setup plan for institution training and support (Based on number of users and number of PCs)

9. 
One-two weeks before CONS All Set Implementation Date (Day 4) for institution. Gather names and telephone numbers of staff as

a post-conversion step.

10. 
One-two weeks before CONS All Determine recovery procedure for this institution

11. 
One-two weeks before CONS Existing Submit request to Appl Prod Support request folder for a customer pending disbursement report.

12. 
One-two weeks before CONS Existing Verify completion of the Consultant Checklist.
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Table 20: [Page 2 of 8] Customer Conversion – 12/17/02 Activity Checklist for Institution _________________________________________
Development Contact _____________________________ Consultant Contact _______________________________________________

Done
Implementation

Scheduled Group Customers Action Completed

13. 
One Week Before BIT New

LBW Users
Define Institution's profile and optional LBW features using the AdvanTG Web Institution
Administration GUI. Mark complete on Consultant Checklist.

14. 
One Week Before CONS New Review, approve, and send all new user requests to BIT

15. 
One Week Before BIT New Provide new institution User IDs to Technical Services – Administration (Security)

16. 
One Week Before SEC New

Users
Insert User IDs in AdvanTG Web LDAP security

17. 
One Week Before SEC Phase I

Users
Export a file containing an institution's Phase 1 security information to be loaded directly to
AdvanTG Web II security database.

18. 
One Week Before DEV1 Phase I

Users
Import Phase I User IDs into AdvanTG Web LDAP security
Transfer User ID, reset password to 'welcome', department, division, Access to RTA (mainframe
IDs password)

19. 
One Week Before SEC New

Users
Return User IDs and passwords to BIT

20. 
One Week Before BIT All Define User ID roles using AdvanTG Web Modify AdvWeb User Profile GUI per Consultant

Checklist.

21. 
One Week Before BIT All Notify BIT-Tech team members and forward the request forms for verification.

22. 
One Week Before BIT New Distribute User IDs and passwords to CONS. (CONS distributes on Day 4 to customers.)

23. 
One Week Before BIT-Tech All Verify institution profile & user roles defined for this institution's users per forms forwarded by BIT.

24. 
Day 1 Customer All Submits final applications, CTs, and EFT approvals (lenders). Lenders send final approvals for

which they want to receive responses. Receive responses from previous batch jobs
Customer performs Send/Receive activities for the day.

                                                     
1 Activities performed by the AdvanTG Web Development Team (DEV) will gradually be performed by Application Development and Support (ADS) team.
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Table 20: [Page 3 of 8] Implementation Week – 12/17/02 Activity Checklist for Institution _________________________________________
Development Contact _____________________________ Consultant Contact _______________________________________________

Done
Implementation

Scheduled Group Customers Action Completed

25. 
Day 1 Customer All Export final response files into their FAMS or LMS. Print necessary reports for institution.

26. 
Day 1 (COB)

Must be submitted
no later than
2:00 p.m. on Day 2.

BIT-Tech All Request Initial Load Extract mainframe jobs - Using REXX panels, specify Institutions,
Loan Status, and Loan Period Begin Date (0-24 months). Loan Status, and Loan
Period Begin Date are taken-off Consultant Checklist.
Specify request for AdvanTG Web Setup and Database Load.
On the request form, check: Next Business Day and Extract, Update, Utility, and
PAWD900R (FTP file transfer) jobs.
Submit request to Production Control.
Fill-out request for AdvanTG Web Setup and Database Load by using form stored at:
Corpfile2\\Everyone\Prod_Cntl Requests\PSG Request Forms
\AdvTG_InitialLoad.doc
Note: This mainframe job must run after batch process completes, about 6 a.m. the next day.

27. 
Day 2 (after 6 a.m.) BIT-Tech All Loan Extraction job runs on mainframe and puts data into CommonLine format. Final step

transfers the Initial Load file (FTP) from mainframe to working production directory folder.

28. 
Day 2 (prior to Noon) Customer

PSG
All Customer receives final files from previous batch jobs. PSG will verify completion and notifies

BIT-Tech. This last Send/Receive should not result in any new send files

29. 
Day 2 (prior to Noon) Customer

PSG
All Customer exports final files into their FAMS or LMS and prints necessary reports.

PSG will verify completion and notify BIT-Tech.

30. 
Day 2 (After Noon) PSG

Bit-Tech
Desktop Check that all activity has stopped and all users are logged out by noon.

Customer sends Desktop database [cb1, chng, and indexes] to BIT-Tech:
• (filesize < 2 MB) Use WinZip compression & email to tgtesting@tgslc.org
• (2 MB < filesize < 15 MB) Save to the Internet and downloaded to TG.
• (filesize >15 MB) Use a CD-ROM burner and send files via FedEx

Alternative: Save to Internet and download to TG if no CD burner is available.

31. 
Day 2 (After Noon) BIT-Tech All Using the UserList INI Utility (developed by Mitchell Reid), shut down the customer's

mailbox access once PSG has notified BIT-Tech that all customer activity is complete.

32. 
Day 2 (afternoon) BIT-Tech Phase 1 Request database for Phase I institution from Application Production and Support.

Submit ServiceCenter Problem Ticket requesting a copy of the institution’s database.
Assign ticket to Appl Prod Support.
In the brief description field, type text: “AWII Conv. Pdox db – Cb1 Chg only.”
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Table 20: [Page 4 of 8] Implementation Week – 12/17/02 Activity Checklist for Institution _________________________________________
Development Contact _____________________________ Consultant Contact _______________________________________________

Done
Implementation

Scheduled Group Customers Action Completed

33. 
Day 2 (afternoon) BIT-Tech All Create a folder for this institution on TG's corporate server:

CorpFile2\\Everyone\AdvanTG Web Conversions\<Institution Name>
Create a subfolder to hold Original copy of the AdvanTG Desktop CB1 CHNG database:
\AdvanTG Web Conversions\<Institution Name>\Pre-Conversion
Create subfolders to hold reports, logs, and record counts from the customer conversion

34. 
Day 2 (afternoon) BIT-Tech Phase 1 Receives notification that the institution's current production database is available. Unzip files first

as needed. Copy and paste customer files to the C:\advantg\data folder on local PCs.

35. 
Day 2 (afternoon) BIT-Tech Desktop

Only

1) Perform Database Repair on customer files
2) Perform Database Packer on customer files
3) Implement AdvanTG upgrade if necessary

Note: If customer’s version of AdvanTG desktop is less than Build 5.1, Phase 1 institutions do not
require upgrade, should already be running Build 5.1.
Refer to Section 2 (step 35) for the very detailed procedure actions.

36. 
Day 2 (afternoon) ADS Desktop Archive AdvanTG Desktop databases received by BIT-Tech.

37. 
Day 2 (afternoon) BIT-Tech Desktop

&
Phase 1

Schools
Only

Create Import CT file for AdvanTG Web Phase II.
Run the modified Export CT

1) Using modified AdvanTG Desktop, login as the institution and export change transactions into
a modified text file.

2) Record number of records exported matches the Change Maintenance window information.
3) Send email to ADS person who will perform the Import CT procedure.
For detailed procedures and background, refer to Section 2 (step 37) and Section 6.

LBW Access for Institution and students is disabled throughout Day Three

38. 
Day 3 DEV LBW

Customers
Disable institution access to LBW & redirect students to "Outage page."

39. 
Day 3 AWII

Testing
LBW

Customers
Verify institution's users are routed to the "Outage Page."

40. 
Day 3 AWII

Testing
LBW

Customers
Verify institution to be converted is marked "completed" in EInstitution table. The nightly
Institution synchronization job ran on the mainframe.
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Table 20: [Page 5 of 8] Implementation Week – 12/17/02 Activity Checklist for Institution _________________________________________
Development Contact _____________________________ Consultant Contact _______________________________________________

Done
Implementation

Scheduled Group Customers Action Completed

41. 
Day 3 AWII

Testing
All Check that institution's Initial Load and Import CT files are ready.

42. 
Day 3 AWII

Testing
All Verify the Customer Conversion Utitlities production software is running.

43. 
Day 3 AWII

Testing
LBW

Customers
Determine record counts for this institution in the LBW Phase 1 Production database. See
Appendix D for the SQL queries used.

44. 
Day 3 AWII

Testing
All Announces ready to begin the customer data conversion. Send emails to BIT and other

conversion team members.

45. 
Day 3 AWII

Testing
All Starts production software used for Customer Conversion Utilities.

46. 
Day 3 AWII

Testing
LBW

Customers
Use Customer Conversion Utilities to change institution from status Phase 1 to Transition.

47. 
Day 3 AWII

Testing
LBW

Customers
Verify institution's users are routed to the "Outage Page."

48. 
Day 3 AWII

Testing
LBW

Customers
Convert LBW loans, basic institution information, URLs, preferred lenders, pending award
certifications, and master demographics to AdvanTG Web data.

49. 
Day 3 AWII

Testing
LBW

Customers
Run SQL queries (see Appendix D) to determine total number of loans/certifications processed.

50. 
Day 3 AWII

Testing
LBW

Customers
Notify Conversion Team and provide record counts using Customer Conversion Utilities.
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Table 20: [Page 6 of 8] Implementation Week – 12/17/02 Activity Checklist for Institution _________________________________________
Development Contact _____________________________ Consultant Contact _______________________________________________

51. 
Day 3 BIT-Tech LBW

Customers
Referring to the record counts from Customer Conversion Utilities, validate that the converted
record counts match the institution's data in LBW:

• Check current LBW database (https:\\adv-prod.tgslc.org) for the number of
certification records:
(a) Login to AdvanTG Web Phase 1 and query LBW production for institution certifications.
(b) Randomly select 10 certification listings according to Period Begin and
Certification Date criteria.

• Verify (with Application Status Report) that all records loaded in AdvanTG Web II, based on
the counts from the previous step and the Application Status Report.

For detailed procedures and background, refer to Section 2 (step 51) and Section 5.

52. 
Day 3 BIT-Tech LBW

Customers
Perform a detailed review of the institution's converted LBW certifications data.
Verify the data for the previously randomly selected certifications. At least 10 records is need to
include at least one of each certification type.
(a) Login to AdvanTG Web II and list institution applications in "L" status.
(b) Verify the mandatory data fields for LBW Certifications exist
(c) If a selected SSN certification is not listed, examine History in AdvanTG Phase 1 for any
second certification created and guaranteed in Phase 1 during same time range.
For detailed procedures and background, refer to Section 2 (step 52) and Section 5.

53. 
Day 3 BIT-Tech LBW

Customers
Sends email notification to Robert Blackard that conversion is complete. Provide the institution's
name, Department of Education ID (DOE ID), and state to configure LDAP security properly.

54. 
Day 3 AWII Test Desktop Import into AdvanTG Web, Change Transactions (CTs) extracted from desktop on Day 2.

55. 
Day 3 AWII

Testing
Desktop Record number of CTs imported and use SQL queries to validate the total number of change

transactions and the numbe of @1-08, @1-09, and @1-10 detail records.

56. 
Day 3 AWII Test Desktop Send email to Conversion Team with the Import CT record counts.

57. 
Day 3 BIT-Tech Desktop Validate that the number of CTs imported into AdvanTG Web II matches the record counts

(a) Verify Import CT record count with tAdvanTG Web II Change Transaction Transmission Log.
(b) Note any discrepancies and send an email notification to BIT team lead and Development
Team/APPL Support.
(c) Review institution's imported change transactions for exact matches by randomly selecting
@1-8, @1-9, and @1-10 records in AdvanTG Web II and comparing with desktop data.
For detailed procedures and background, refer to Section 2 (step 57) and Section 6.
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Table 20: [Page 7 of 8] Implementation Week – 12/17/02 Activity Checklist for Institution _________________________________________
Development Contact _____________________________ Consultant Contact _______________________________________________

Done
Implementation

Scheduled Group Customers Action Completed

58. 
Day 3 AWII

Testing
Large Loan

Volume
For large institutions, split the CL response file into smaller CL response sub-files so that they are
converted efficiently for AdvanTG Web II database.

59. 
Day 3 AWII

Testing
All (a) Examine the CL Response File and sub-files for record counts.

(b) Place the file(s) in the AdvanTG Web II BPLM folder.

60. 
Day 3 AWII

Testing
All Run two SQL queries (see Appendix D) to determine the number of loans and detect any

CommonLine parsing errors. Ensure loans inserted in AdvanTG Web tables equals the CL
Response file record counts.

61. 
Day 3 AWII

Testing
All Send number of loans/record counts in email to Conversion Team Members

62. 
Day 3 BIT-Tech All Review institution's initial load (guaranteed loans) in AdvanTG Web II system.

Verify record count using the AdvanTG Web Receive Results Report record count.
Note: The number of loan records in AdvanTG Web II is nearly the same as the number of
records extracted. There may be a few discrepancies due to invalid data from the mainframe.
For detailed procedures and background, refer to Section 2 (step 60) and Section 7.

63. 
Day 3 DEV All Mark all loans and CTs as "exported" and backdate all receive dates in the affected AdvanTG

Web II database tables by 24 hours using the Customer Conversion Utilities.

64. 
Day 3 BIT-Tech All Review institution's marked change transactions and loans by attempting to export records from

AdvanTG Web II and examining number of CL4 records available to export.
For detailed procedures and background, refer to Section 2 (step 64) and Section 8.

65. 
Day 3 AWII

Testing
LBW

Customers
Use Customer Conversion Utilities to change the institution from Transition to Phase 2.

66. 
Day 3 AWII

Testing
LBW

Customers
Verify LBW users are now routed to the AdvanTG Web II system.

67. 
Day 3 AWII

Testing
All Send email to Technical Services DBA, request that they run database statistics update.
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Table 20: [Page 8 of 8] Implementation Week – 12/17/02 Activity Checklist for Institution _________________________________________
Development Contact _____________________________ Consultant Contact _______________________________________________

Done
Implementation

Scheduled Group Customers Action Completed

68. 
Day 3 BIT-Tech Existing

Desktop &
Phase 1

Post most recent production responses (last batch results):
Access customer's production mailbox (Moray server) and copy files to  corporate server folder:
…\AdvanTG Web Conversions\<Institution Name>\<MailBox ID>
<MailBox ID> is shown in Appendix A – Institution Information.
Use Decrypt Utility to convert data to plain text, save files in Conversion-II folder,
Rename files to conform to AdvanTG Web II file naming standards (as needed)
Drop a copy of the file(s) in the same BPLM so the CMLN files can be moved to the proper
server. \\Moray\BE_BPLM
See Section 2, step 68 for additional details and section 10 for File Renaming Standards.

69. 
Day 3 BIT-Tech As Needed Modify production TG Tables (CommonLine and ConnecTG) to send all responses for this

institution (associated trading partners) to the institution's new AdvanTG Web II email address.

70. 
Day 3 DEV All Archive all intermediate customer conversion files used during Initial Load and CT Import.

See Sections 6 and 7 of this document.

71. 
Day 3 BIT-Tech All Sign-off review of institution's converted data.

72. 
Day 3 BIT All BIT lead or backup sends an email to the Conversion Group that the institution's data conversion

review is complete. Notify Technical Services DBA to run statistics command.

73. 
Day 3 TS All Database administrator runs statistics command after each institution to optimize new queries.

74. 
Day 3 BIT-Tech All Create TG WareHouse BASE profile

75. 
"Go-live" (Day 4) SEC All Disable Phase I portal and activate AdvanTG Web II User IDs

76. 
"Go-live" (Day 4) DEV LBW Redirect LBW students to AdvanTG Web II Complete Loan Application

77. 
"Go-live" (Day 4) CONS All Provide access information to users (User IDs and passwords).

78. 
"Go-live" (Day 4) CONS All Check Internet Browser settings and proxy server setup.

Refer to Appendix E – Internet Browser Settings on page 104 for browser/proxy settings.

79. 
"Go-live" (Day 4) CONS All Provide initial training and proactive customer support
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Appendix C – LBW Conversion Quality Assurance
Note: The SQL statements shown in this appendix were composed by Eric Schneider during the testing of the LBW Conversion
process. The SQL statements permit you to examine records that are:
(1) Read from the LBW database
(2) Inserted into the AdvanTG Web II database tables
(3) Remove the data records from AdvanTG Web tables if they are unacceptable.

Note: The LBW Conversion quality assurance SQL scripts can be found in Visual SourceSafe. The folder/file name is:
$/AdvWeb/Testing/Data Conversion/LBW/SQL_LBW_Conversion.txt

Note: Use the script syntax directly from the the Visual SourceSafe file, not the SQL text found in this document.

Note: Each of the SQL examples assumes that the institution ID is 00366300.

Figure 27: LBW Conversion SQL – School URLs
SCHOOL URLs and FEATURES
AdvanTG Web II Database Tables: dinstitutionurl and dinstitutionfeatr

Access LBW Database - School URLs/Features
SELECT substr(SCHOOL,1,8) as SCHOOL, SCHNAME, SCHADDR1, SCHADDR2, SCHCITY, SCHSTATE, SCHZIP9, SCHPHONE, COUNSELING_URL, TEST_URL,
HOMEPAGE_URL FROM SCHOOL WHERE SCHOOL LIKE '00366300%'

Displaying URLs and Features in AdvanTG Web II Database Tables
URLS
select a.lastupdatedtime, a.institutionoid, CASE when a.urltypecode='HO' then 'HOMEPAGE' when a.urltypecode='EC' then 'ENT COUNSEL'
when a.urltypecode='FS' then 'FACT SHT' when a.urltypecode='LO' then 'LOGO' when a.urltypecode='ES' then 'E-SIGN' when
a.urltypecode='T' then 'TESTING' when a.urltypecode='Q' then 'QUERY' else 'UNKNOWN' END as URL_TYPE, a.urltypecode, a.url, b.doeid,
b.name from atgw.dinstitutionurl a inner join atgw.einstitution b on a.institutionoid=b.oid WHERE b.doeid='00366300'

FEATURES
select CASE when a.featurecode='A' then 'ADVWB' when a.featurecode='B' then 'LBW BATCH IMPORT' when a.featurecode='C' then 'LBW
IMPORT' when a.featurecode='D' then 'DISPLAY TO BORROWER' when a.featurecode='E' then 'ENT COUNSEL' when a.featurecode='G' then 'E
SIGN' when a.featurecode='I' then 'INST GUAR' when a.featurecode='L' then 'PLUS LBW' when a.featurecode='M' then 'MPN LBW' when
a.featurecode='P' then 'PARENT INIT' when a.featurecode='R' then 'PREAPPROVED LENDER' when a.featurecode='S' then 'STDNT INIT' when
a.featurecode='T' then 'EFT' when a.featurecode='1' then 'TG ELIGIBLE' when a.featurecode='2' then 'PRELOAD ROSTER' else 'UNKNOWN'
END as feature, a.featurecode, b.doeid, b.oid, b.name, a.lastupdatedtime from atgw.dinstitutionfeatr a inner join atgw.einstitution
b on a.institutionoid=b.oid WHERE b.doeid='00366300'
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Deleting School URLs and Features from AdvanTG Web II Database Tables
URLS
delete from atgw.dinstitutionurl where institutionoid in (select a.institutionoid from atgw.dinstitutionurl a inner join
atgw.einstitution b on a.institutionoid=b.oid WHERE b.doeid='00366300')

FEATURES
delete from atgw.dinstitutionfeatr where institutionoid in (select  a.institutionoid from atgw.dinstitutionfeatr a inner join
atgw.einstitution b on a.institutionoid=b.oid
WHERE b.doeid='00366300')

Figure 28: LBW Conversion SQL – Preferred Lenders

PREFERRED LENDERS
AdvanTG Web II Database Tables: dpreferredlender

Access LBW Database - Preferred Lenders
SELECT substr(SCHOOL,1,8) as SCHOOL, substr(SCHOOLLENDER.LENDER,1,6) as LENDER, SORTORDER FROM SCHOOLLENDER JOIN LENDER ON
(SCHOOLLENDER.LENDER = LENDER.LENDER AND LENDER.PARTICIPANT='Y') WHERE SCHOOL LIKE '00366300%'

Displaying Preferred Lenders in AdvanTG Web II Database Tables
select a.sortorder as sort, c.name as lender, c.doeid as lenderdoeid, b.name as school, b.doeid as schooldoeid from
atgw.dpreferredlender a inner join  atgw.einstitution b on a.owneroid=b.oid inner join atgw.einstitution c on
a.preferredlenderoid=c.oid where b.doeid='00366300' order by a.sortorder

Deleting Preferred Lenders from AdvanTG Web II Database Tables
delete from atgw.dpreferredlender where owneroid in (select b.oid from atgw.dpreferredlender a inner join  atgw.einstitution b on
a.owneroid=b.oid where b.doeid='00366300')
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Figure 29: LBW Conversion SQL – MPN Applications

MPN APPS (MPN Applications are in Ready 'L' status)
AdvanTG Web II Database Tables: eperson, eloan, ddisbursement

Access LBW Database - MPN Applications
SELECT count(*) FROM STAFFORD A JOIN BORROWER B1 ON A.BSSN = B1.BSSN WHERE A.SCHOOL LIKE '00366300%' AND A.STATUS = 'ACTIVE' AND
(A.FORM_CD = 'M' or A.FORM_CD = 'B') AND A.PERBEG > current date - 1 year

Displaying MPN Applications in the AdvanTG Web II Database Tables
select a.* from atgw.eloan a inner join atgw.einstitution b on a.instowneroid=b.oid where a.createuserid like 'LBW DATA CONV%' and
b.doeid='00366300' and a.loantype in ('SF','SU','CS') and a.loanstatus='R'

select * from atgw.eperson where loanoid in (select a.oid from atgw.eloan a inner join atgw.einstitution b on a.instowneroid=b.oid
where a.createuserid like 'LBW DATA CONV%' and b.doeid='00366300' and a.loantype in ('SF','SU','CS') and a.loanstatus='R')

select  b.* from atgw.eloan a inner join atgw.ddisbursement b on b.loanoid=a.oid inner join atgw.einstitution c on
c.oid=a.instowneroid where c.doeid in ('00366300') and a.loantype in ('SF','SU','CS') and a.loanstatus='R' and a.createuserid like
'LBW DATA CONV%'

Deleting MPN Applications from AdvanTG Web II Database Tables
delete from atgw.eperson where loanoid in (select a.oid from atgw.eloan a inner join atgw.einstitution b on a.instowneroid=b.oid
where a.createuserid like 'LBW DATA CONV%' and b.doeid='00366300' and a.loantype in ('SF','SU','CS') and a.loanstatus='R')

delete from atgw.ddisbursement where loanoid in (select  b.loanoid from atgw.eloan a inner join atgw.ddisbursement b on
b.loanoid=a.oid inner join atgw.einstitution c on c.oid=a.instowneroid
where c.doeid in ('00366300') and a.loantype in ('SF','SU','CS') and a.loanstatus='R' and a.createuserid like 'LBW DATA CONV%')

delete from atgw.eloan where oid in (select a.oid from atgw.eloan a inner join atgw.einstitution b on a.instowneroid=b.oid where
a.createuserid like 'LBW DATA CONV%' and b.doeid='00366300' and a.loantype in ('SF','SU','CS') and a.loanstatus='R')
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Figure 30: LBW Conversion SQL – PLUS Applications

PLUS APPS (PLUS Applications are in Ready 'L' status)
Note: No Credit Info converted
AdvanTG Web II Database Tables: eperson, eloan, ddisbursement

Access LBW Database - PLUS Applications
SELECT count(*) FROM STAFFORD A LEFT OUTER JOIN BORROWER B1 ON A.BSSN = B1.BSSN JOIN BORROWER B2 ON A.STDNT_SSN = B2.BSSN WHERE
A.SCHOOL LIKE '00366300%' AND A.STATUS = 'ACTIVE' AND A.FORM_CD = 'P' AND A.PERBEG > current date - 1 year

Displaying PLUS Applications in AdvanTG Web II Database Tables
select a.* from atgw.eloan a inner join atgw.einstitution b on a.instowneroid=b.oid where a.createuserid like 'LBW DATA CONV%' and
b.doeid='00366300' and a.loantype='PL' and a.loanstatus='R'

select * from atgw.eperson where loanoid in (select a.oid from atgw.eloan a inner join atgw.einstitution b on a.instowneroid=b.oid
where a.createuserid like 'LBW DATA CONV%' and b.doeid='00366300' and a.loantype='PL' and a.loanstatus='R')

select  b.* from atgw.eloan a inner join atgw.ddisbursement b on b.loanoid=a.oid inner join atgw.einstitution c on
c.oid=a.instowneroid where c.doeid in ('00366300') and a.loantype='PL' and a.loanstatus='R' and a.createuserid like 'LBW DATA CONV%'

Deleting PLUS Applications from AdvanTG Web II Database Tables
delete from atgw.eperson where loanoid in (select a.oid from atgw.eloan a inner join atgw.einstitution b on a.instowneroid=b.oid
where a.createuserid like 'LBW DATA CONV%' and b.doeid='00366300' and a.loantype='PL' and a.loanstatus='R')

delete from atgw.ddisbursement where loanoid in (select b.loanoid from atgw.eloan a inner join atgw.ddisbursement b on
b.loanoid=a.oid inner join atgw.einstitution c on c.oid=a.instowneroid
where c.doeid in ('00366300') and a.loantype='PL' and a.loanstatus='R' and a.createuserid like 'LBW DATA CONV%')

delete from atgw.eloan where oid in (select a.oid from atgw.eloan a inner join atgw.einstitution b on a.instowneroid=b.oid where
a.createuserid like 'LBW DATA CONV%' and b.doeid='00366300' and a.loantype='PL' and a.loanstatus='R')
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Figure 31: LBW Conversion SQL – MPN Certifications

MPN CERTS (These are in LBW 'L' status)
AdvanTG Web II Database Tables: eperson, eloan, ddisbursement

Access LBW Database - MPN Certifications
SELECT count(*) FROM AWARD A JOIN BORROWER B1 ON A.BSSN = B1.BSSN LEFT OUTER JOIN STAFFORD S ON A.CREATED = S.AWARDCREATED LEFT
OUTER JOIN HISTORY H ON A.CREATED = H.AWARDCREATED WHERE A.SCHOOL LIKE '00366300%' AND (A.STATUS = 'ACTIVE' OR (S.STATUS IS NULL AND
H.STATUS IS NULL)) AND (A.FORM_CD = 'M' or A.FORM_CD = 'B') AND A.PERBEG > current date - 1 year AND A.SCERTDAT > current date - 2
years

Displaying MPN Certifications in AdvanTG Web II Database Tables
(This will show the sum of results from MPN CERTS and MPN APPS)

select count(a.oid) from atgw.eloan a inner join atgw.einstitution b on a.instowneroid=b.oid where a.createuserid like 'LBW DATA
CONV%' and b.doeid='00366300' and a.loantype in ('SF','SU','CS') and a.loanstatus='L'

select count(*) from atgw.eperson where loanoid in (select a.oid from atgw.eloan a inner join atgw.einstitution b on
a.instowneroid=b.oid where a.createuserid like 'LBW DATA CONV%' and b.doeid='00366300' and a.loantype in ('SF','SU','CS') and
a.loanstatus='L')

select count(a.oid) from atgw.eloan a inner join atgw.ddisbursement b on b.loanoid=a.oid inner join atgw.einstitution c on
c.oid=a.instowneroidwhere c.doeid in ('00366300') and a.loantype in ('SF','SU','CS') and a.loanstatus='L' and a.createuserid like
'LBW DATA CONV%'

Deleting MPN Certifications from AdvanTG Web II Database Tables
delete from atgw.eperson where loanoid in (select a.oid from atgw.eloan a inner join atgw.einstitution b on a.instowneroid=b.oid
where a.createuserid like 'LBW DATA CONV%' and b.doeid='00366300' and a.loantype in ('SF','SU','CS') and a.loanstatus='L')

delete from atgw.ddisbursement where loanoid in (select  b.loanoid from atgw.eloan a inner join atgw.ddisbursement b on
b.loanoid=a.oid inner join atgw.einstitution c on c.oid=a.instowneroid
where c.doeid in ('00366300') and a.loantype in ('SF','SU','CS') and a.loanstatus='L' and a.createuserid like 'LBW DATA CONV%')

delete from atgw.eloan where oid in (select a.oid from atgw.eloan a inner join atgw.einstitution b on a.instowneroid=b.oid where
a.createuserid like 'LBW DATA CONV%' and b.doeid='00366300' and a.loantype in ('SF','SU','CS') and a.loanstatus='L')
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Figure 32: LBW Conversion SQL – PLUS Certifications

PLUS CERTS (These are in LBW 'L' status)
AdvanTG Web II Database Tables: eperson, eloan, ddisbursement

Access LBW Database - PLUS Certifications
SELECT count(*) FROM AWARD A LEFT OUTER JOIN BORROWER B1 ON A.BSSN = B1.BSSN JOIN BORROWER B2 ON A.STDNT_SSN = B2.BSSN LEFT OUTER
JOIN STAFFORD S ON A.CREATED = S.AWARDCREATED LEFT OUTER JOIN HISTORY H ON A.CREATED = H.AWARDCREATED WHERE A.SCHOOL LIKE
'00366300%' AND (A.STATUS = 'ACTIVE' OR (S.STATUS IS NULL AND H.STATUS IS NULL)) AND A.FORM_CD = 'P' AND A.PERBEG > current date - 1
year AND A.SCERTDAT > current date - 2 years

Displaying PLUS Certifications in AdvanTG Web II Database Tables
select count(a.oid) from atgw.eloan a inner join atgw.einstitution b on a.instowneroid=b.oid where a.createuserid like 'LBW DATA
CONV%' and b.doeid='00366300' and a.loantype in ('PL') and a.loanstatus='L'

select count(*) from atgw.eperson where loanoid in (select a.oid from atgw.eloan a inner join atgw.einstitution b on
a.instowneroid=b.oid where a.createuserid like 'LBW DATA CONV%' and b.doeid='00366300' and a.loantype in ('PL') and
a.loanstatus='L')

select count(*) from atgw.eloan a inner join atgw.ddisbursement b on b.loanoid=a.oid inner join atgw.einstitution c on
c.oid=a.instowneroid where c.doeid in ('00366300') and a.loantype in ('PL') and a.loanstatus='L' and a.createuserid like 'LBW DATA
CONV%'

Deleting PLUS Certifications from AdvanTG Web II Database Tables
delete from atgw.eperson where loanoid in (select a.oid from atgw.eloan a inner join atgw.einstitution b on a.instowneroid=b.oid
where a.createuserid like 'LBW DATA CONV%' and b.doeid='00366300' and a.loantype in ('PL') and a.loanstatus='L')

delete from atgw.ddisbursement where loanoid in (select  b.loanoid from atgw.eloan a inner join atgw.ddisbursement b on
b.loanoid=a.oid inner join atgw.einstitution c on c.oid=a.instowneroid
where c.doeid in ('00366300') and a.loantype in ('PL') and a.loanstatus='L' and a.createuserid like 'LBW DATA CONV%')

delete from atgw.eloan where oid in (select a.oid from atgw.eloan a inner join atgw.einstitution b on a.instowneroid=b.oid where
a.createuserid like 'LBW DATA CONV%' and b.doeid='00366300' and a.loantype in ('PL') and a.loanstatus='L')
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Appendix D – Customer Conversion Validation Queries

Determine Record Counts for LBW Institutions from LBW Production
Use the SQL queries illustrated in Table 21 to directly get a count of specific LBW information.

For these queries you will need to replace the fields:

• <<doeid>> with the 9-digit institution DOE ID number
• current date with todays date

Table 21: SQL Queries for LBW Record Counts
LBW Information SQL Query Statement (with input fields in bold)

School URLs SELECT count(*) SCHURL FROM SCHOOL WHERE SCHOOL LIKE '<<doeid>>%'

Preferred Lenders SELECT count(*) PREFLEND FROM SCHOOLLENDER JOIN LENDER ON (SCHOOLLENDER.LENDER =
LENDER.LENDER AND LENDER.PARTICIPANT='Y') WHERE SCHOOL LIKE '<<doeid>>%'

MPN Applications SELECT count(*) MPNAPPS FROM STAFFORD A JOIN BORROWER B1 ON A.BSSN = B1.BSSN WHERE A.SCHOOL
LIKE '<<doeid>>%' AND A.STATUS = 'ACTIVE' AND (A.FORM_CD = 'M' or A.FORM_CD = 'B') AND
A.PERBEG > current date - 1 year

MPN Certifications SELECT count(*) MPNCERTS FROM AWARD A JOIN BORROWER B1 ON A.BSSN = B1.BSSN LEFT OUTER JOIN
STAFFORD S ON A.CREATED = S.AWARDCREATED LEFT OUTER JOIN HISTORY H ON A.CREATED =
H.AWARDCREATED WHERE A.SCHOOL LIKE '<<doeid>>%' AND (A.STATUS = 'ACTIVE' OR (S.STATUS IS
NULL AND H.STATUS IS NULL)) AND (A.FORM_CD = 'M' or A.FORM_CD = 'B') AND A.PERBEG >
current date - 1 year AND A.SCERTDAT > current date - 2 years

PLUS Applications SELECT count(*) PLUSAPPS FROM STAFFORD A LEFT OUTER JOIN BORROWER B1 ON A.BSSN = B1.BSSN
JOIN BORROWER B2 ON A.STDNT_SSN = B2.BSSN WHERE A.SCHOOL LIKE '<<doeid>>%' AND A.STATUS =
'ACTIVE' AND A.FORM_CD = 'P' AND A.PERBEG > current date - 1 year

PLUS Certifications SELECT count(*) PLUSCERTS FROM AWARD A LEFT OUTER JOIN BORROWER B1 ON A.BSSN = B1.BSSN JOIN
BORROWER B2 ON A.STDNT_SSN = B2.BSSN LEFT OUTER JOIN STAFFORD S ON A.CREATED =
S.AWARDCREATED LEFT OUTER JOIN HISTORY H ON A.CREATED = H.AWARDCREATED WHERE A.SCHOOL LIKE
'<<doeid>>%' AND (A.STATUS = 'ACTIVE' OR (S.STATUS IS NULL AND H.STATUS IS NULL)) AND
A.FORM_CD = 'P' AND A.PERBEG > current date - 1 year AND A.SCERTDAT > current date –
 2 years
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Verify Conversion Record Counts in AdvanTG Web Database
Use the SQL queries illustrated in Table 22 to directly validate a Customer Conversion step shown in Section 2 on page xx.

For these queries you will need to replace the fields:

• <<doeid>> with the 9-digit institution DOE ID number
• current date with todays date

Table 22: SQL Queries to Verify AdvanTG Web Database Counts
Information Counts to Verify
in AdvanTG Web Database SQL Query Used

LBW Institution phase set to Transition Select * from atgw.tlbwinst where doeid='<<doeid>>'

Number of LBW
MPN/PLUS loans and certifications inserted

Select count(*) from atgw.eloan where instowneroid in (select oid from
atgw.einstitution where doeid='<<doeid>>')

Change Transactions imported from the
AdvanTG Desktop database

Total Change Transactions

Select count(*) from atgw.echangetrans where instowneroid in (select oid
from atgw.einstitution where doeid='<<doeid>>')

Detail Records (@1-08,@1-09,@1-10)

Select count(*) from atgw.dctdetail where ctoid in (Select oid from
atgw.echangetrans where instowneroid in (select oid from
atgw.einstitution where doeid='<<doeid>>'))

Initial Load file loans and any errors that
happened when the files were processed
(parsed) through the B2B Server.

Select count(*) from atgw.eloan where instowneroid in (select oid from
atgw.einstitution where doeid='<<doeid>>')

Select count(*) from atgw.eparseinformation where owneroid in (select oid
from atgw.einstitution where doeid='<<doeid>>') and parsestatus='E'

Select count(*) from atgw.eparseinformation where owneroid in (select oid
from atgw.einstitution where doeid='<<doeid>>') and parsestatus='S'

LBW Institution phase set to 2 Select * from atgw.tlbwinst where doeid='<<doeid>>'
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Appendix E – Internet Browser Settings
When new customers begin using the AdvanTG Web II application, the client Internet
Browsers must meet specific requirements and have key settings active.

Table 23: Global Internet Browser/Computer Settings
Description Setting

Internet Browser Software • Internet Explorer version 5.5 or later
• Netscape® Commander version 6.0 or later

Windows® Operating Systems • Windows 2000 or NT
• Windows 98 or Windows 95
• Windows XP

Computers • IBM Compatible PCs
CAUTION: AdvanTG Web II does not work with Macintoshes

Memory • 64 MB of RAM memory or more

Screen Resolution • 800 x 600 pixels [MUST be this setting]

Proxy Server [If needed] • Identify name of proxy server for this institution for
HTTP, Secure HTTP, and FTP

Javascript • Enabled

Adobe Acrobat Plug-in • See Obtaining Adobe Acrobat Reader

Caching • Enabled

Cookies • Enabled

Caution: For users running Windows 2000 and who wish to use the
AdvanTG Web II Letter Writing Component (LWC),
You MUST install Windows 2000 Office Service Pack 2 for correct operation.

For all AdvanTG Web II users who wish to use the Letter Writing Component
(LWC), you MUST use Internet Explorer as your browser.

Obtaining Adobe Acrobat Reader
For working with Adobe Acrobat PDF (Portable Digital Format) files in AdvanTG Web II.
Your browser must have been installed with the Adobe Acrobat plug-in or your must
download/install a version of Adobe Acrobat Reader.

Procedure: Test for Adobe Acrobat Plug-in
1. Start Internet Explorer or Netscape Navigator software.
2. Select the Open command from the File menu.
3. Browse for a file that ends with the file extension  .pdf.
4. Click OK and attempt to display the file. The PDF file will display properly if the Adobe

plug-in has been installed in this browser.
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URL to Find Adobe Acrobat Reader Plug-In
• Windows 95/98/NT/2000/XP

http://www.adobe.com/products/acrobat/readstep2.html
File size is 8.6 MB

Note: Adobe Acrobat 4.x and later and Adobe Acrobat Reader 4.x and later include
ActiveX plug-in files for Windows NT 4.0, Windows Me, Windows 2000, Windows 98,
and Windows 95. (Acrobat 4.x and Acrobat Reader 4.x do not support Windows Me.)

Configuring Computers/Browsers for Proper Operation
Configuring Internet Browser and Windows settings for Windows NT and Windows 2000 are
similar operations.

Table 24: Configuring Internet Browser/Computer Settings
Setting How to Change Setting

Internet Browser Version Identify
Internet Explorer
or
Netscape Navigator

Start the Browser software
Select the Help » About Internet Explorer menu command
or
Select the Help » About Netscape 6 menu command

RAM Memory Select Start » Settings » Control Panel command
Double-click the System icon
View amount of memory on the General dialog tab

Screen Resolution Select Start » Settings » Control Panel command
Double-click the Display icon
On Display Properties window, select Setting dialog tab
In Desktop Area, move slider to 800 x 600 pixels

Javascript
Internet Explorer

Netscape Navigator

• Select Tools » Internet Options command
Select Security dialog tab, click Custom Level button
In Security Settings window, scroll to Scripting
Choose Enable for Active scripting
Click OK twice to close the Internet Options window.

• Select Edit » Preferences command
Click the Advanced category.
Select the Enable Javascript for Navigator checkbox
Click OK to close the Preferences window..

http://www.adobe.com/products/acrobat/readstep2.html
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Caching
Internet Explorer

Netscape Navigator

• Select Tools » Internet Options command
Select General dialog tab, click Settings button
In Settings window, select Automatically option button
Click OK twice to close the Internet Options window.

• Select Edit » Preferences command
Under the Advanced category, click Cache.
Enter a number in the Memory Cache field to specify the
size of the memory cache. 1024K to 2000K is a good size.
To clear the memory cache immediately,
click Clear Memory Cache.
Click OK to close the Preferences window.

Cookies
Internet Explorer

Netscape Navigator

• Select Tools » Internet Options command
Select Security dialog tab, click Custom Level button
In Security Settings window, scroll to Cookies
Choose Enable for Per session cookies (not stored)
Click OK twice to close the Internet Options window.

• Select Edit » Preferences command
Under Privacy and Security category, choose Cookies.
(If no sub-categories are visible, click to expand the list.)
Select the Enable all cookies option button
Click OK to close the Preferences window.

Proxy Servers
Some institutions require users to configure their Internet Browsers to use a "proxy server" for
specific protocols through their firewalls. Consult with the TG institution's network
administrator to get the name of the proxy server and the port numbers used.

Note: The proxy server name and port numbers used in these figures/table are
example names and ports only.

Table 25: Identifying Internet Browser Proxy Servers
Internet Browser Identify the Proxy Server

Internet Explorer • Select the Internet Options command under the Tools menu
Select the Connections dialog tab
Click LAN Settings button, then click the  Advanced button
Insert the name of your institution's proxy server and port number into
the fields in Figure 33: Internet Explorer Proxy Configuration on page
107.
Click OK three times to close all the dialogs.

Netscape Navigator • Select the Preferences command under the Edit menu
Click Advanced heading, then click Proxies subheading
Insert the your institution's proxy server name and port number into the
fields in Figure 34: Netscape Navigator Proxy Configuration on page 107
Click OK.
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Figure 33: Internet Explorer Proxy Configuration

Figure 34: Netscape Navigator Proxy Configuration
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Troubleshooting Browser Configurations
When a user calls Customer Support and reports one of the symptoms described in Table 26:
Troubleshooting Internet Browser Settings, you should examine the Internet Browser settings
to see that the requirements listed in Table 23: Global Internet Browser/Computer Settings are
met. The instructions for checking and changing the Internet Browser settings can be found in
Table 24: Configuring Internet Browser/Computer Settings on page 105.

Table 26: Troubleshooting Internet Browser Settings
Browser
Software Setting User Problem Symptoms

Windows IE Scripting not enabled
(Go to page 105.)

Pages do not display when hyperlinks clicked
No action from buttons

Netscape Scripting not enabled
(Go to page 105.)

Pages do not display when hyperlinks clicked
No action from buttons

Windows IE Cookies not enabled
(Go to page 106.)

System requests you to login again
Login page does not fully display

Netscape Cookies not enabled
(Go to page 106.)

System requests you to login again
Login page does not fully display
Windows displays Javascript code

Windows IE Caching not enabled
(Go to page 106.)

Slower response time for application

Netscape Caching not enabled
(Go to page 106.)

Slower response time for application
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